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THE LIBRARY 
WORKSPACE
Generally speaking, the panels 
on the left side of the Library 
module are used for organizing 
your photos and videos, while 
the right-side panels are used 
to apply metadata and Develop 
adjustments to selected photos 
and videos (see Figure 3–2). 
You’ll use multiple methods of 
viewing your photos and videos, 
called view modes, and you have 
many, many options available for 
sorting and arranging photos any 
way you want to.

LIBRARY: Managing your photos with Lightroom 
Once you’ve imported photos and videos into the catalog, the next tasks are to get 
everything organized and to separate the best from the rest. The Library module is your 
command center for managing all your photo and video files, both within the catalog 
and on the hard drive.

During the import, Lightroom indexed 
your files with the catalog. Remember that 
what you’re seeing in Library are previews 
of Lightroom’s processing of the files, which 
are referenced on disk. (So don’t think now 
that your photos are “in the catalog” you can 
delete them from the hard drive!)

That said, you can work with your photos and 
videos in Lightroom as if you were working 
directly with the files on disk. All the work you 
do in Lightroom is automatically saved in the 
catalog and you can also save that metadata 
to the hard drive. (Whenever you’re working 
on photos in Lightroom, you’re working 
with metadata; this is covered extensively 
throughout this chapter.)

How Library interacts with your 
computer’s file system
Although Lightroom is referencing the files and 
rendering previews as you work, when you 
make changes to the file system from within 
Lightroom, those changes also happen on 
disk. For example, if you rename a photo from 
within the catalog, that file is renamed on the 
hard drive. If you move a folder in Lightroom, 
the folder gets moved on the hard drive. If you delete photos from the catalog, you have 
the choice of whether or not to also delete them from disk. As I’ve repeatedly mentioned 
elsewhere in this book, once photos have been imported to a catalog, you should always do 
any re-organizing from within Lightroom, and Library is where this happens.

Multiple ways of organizing
Aside from the folder systems where you store your photos on the hard drive, the greatest 
advantage of working in the Lightroom catalog is that you can also use many other 
organizational methods to sort, group and find your photos and videos. Collections, filters and 
keywords are among the many ways you can view your digital media within the catalog. 
You will likely use one fixed folder structure on your hard disk and an unlimited number of 
other—and more flexible—organizational structures within the catalog (see Figure 3–1).

Video editing controls and 
Quick Develop video

Quick Develop presets are 
organized in folders

Layout Overlay in Loupe view
Stacks are now available in 

collections 
Filters and smart collections 

can use Metadata Status 
and dng parameters

Flag status is now global
Navigator adds 1:8 and 1:16 

zoom ratios
New options on the Folders 

panel
Move multiple folders at once
Make collections from folders 

using drag-and-drop
Additions to the Info Overlays 

and Expanded Cell Extras
New file naming templates
Updates to the Keyword List 

and Metadata panels
Publish Service updates

What’s New in Library

Figure 3-2

Figure 3-1

⌘+Option+1 
or Ctrl+Alt+1
Go to Library 
module
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The sections of this chapter are sequenced to generally correspond with the way the Library 
module is laid out and the order in which you’ll see things as you look around the window. 
However, understand that this does not necessarily correspond with the steps in the 
workflow you may use. For example, the Metadata panel is at the bottom of the right panel 
group, which might lead you to assume that it’s the least important thing. This couldn’t be 
further from the truth; in fact, working on the Metadata panel is something that you’ll do 
with increasing regularity as you master Lightroom. In some cases, for clarity, we’ll need to 
jump around a bit.

(One other note: where I refer to “photos”, 
in most cases I also mean videos.)

ABOUT PHOTO EDITING
Editing photos is an iterative process: you’ll 
review your photos in multiple sequential 
passes until they are distilled down to the 
final selects (see Figure 3–3). The goal is to 
go from the many images captured during 
a session to only your best photos—those 
chosen to continue through the processing 
pipeline. You will always start out with 
many photos that may not survive the 
editing process; even for many professional 
photographers, a ratio of 1:100 keepers 
vs. cuts is common! During each round 
of editing, decide whether each image 
stays or goes. “Maybes” stay; at least for the 
current round.

Try to look at your photographs as if someone else made them. Be your own toughest critic—
you have too many good shots to waste time on bad ones! During the initial rounds of editing, 
try to move through your editing at a brisk pace, without either over-analyzing or making overly 
emotional decisions. Is the shot successful or not? Does it have immediate impact? Or, does it 
have less-than-obvious potential that can be brought out in processing? Use the fundamentals 
of photography to make your choices—interesting subject or theme, strong composition, good 
exposure and focus, etc. Clearly define your reasons for giving each photo a positive ranking. 
Evaluate similar photographs heuristically (ranked in ascending order) to determine the best—
and ignore the rest. Don’t fret over your decisions—you can always come back later to confirm 
your initial choices and you always have the prerogative to change your mind.

As you go through your edit, you can switch between the four view modes (Grid, Loupe, 
Compare and Survey) to evaluate larger previews or compare multiple images. We’ll look 
at all of these in a bit. Also, sometimes you’ll want to do some processing to make a better 
decision about how to rate an image; you can do this in Library’s Quick Develop. (But don’t 
get too mired in processing during the early stages of editing; just concentrate on picking 
your favorites.) Once you’ve identified your best work from each batch of photos, you’ll 
move on to enhance them in Develop.

Figure 3-3

Edit a shoot
Below is a simplified editing workflow that you can use to very quickly edit a photo 
shoot down to your final selects. This workflow is not perfect for every photographer 
or every situation, but it will get you headed in the right direction. All the steps and 
controls are explained in detail throughout the remainder of this chapter.

Step 1. In the Folders panel, select the folder of photos and videos to work with. 
(Usually it’s best to not start the workflow in the Previous Import source; this is 
explained later.)

Step 2. Select all the photos, and from the Metadata panel, apply your metadata preset 
(if you didn’t do this during import).

Step 3. With all the photos still selected, apply a few general keywords common to all 
items. If you wish, you can also apply other general iptc metadata (such as Location) at 
this time.

Step 4. Review the photos one by one, and for your initial selects, apply a rating of one star. 
You can do this by clicking the stars in the preview or on the Toolbar, or with the numeric 
keys on your keyboard. You can also apply Reject Flags to photos to be deleted later.

If you want to adjust photos at this point, you can apply some basic processing using 
the controls on the Quick Develop panel.

Step 5. Enable a filter to show only the photos with one star. (The filters are accessed 
from the right side of the Filmstrip or the Filter Bar at the top of the Grid.)

Step 6. Viewing only the one-star photos, go through them a second time and apply a 
rating of two stars to the photos that will advance through this round. Be more critical 
on this cut—you need to start eliminating shots that don’t make the grade.

Step 7. Enable a filter to show only the photos with two stars.

… and so on. You can use as many rounds of editing as necessary to get down to your 
final selects. Sometimes one or two passes are all that are needed; other times you 
might need to go through the shoot numerous times, filtering down your Grid view 
each time. Whatever the case, be sure that when you’re done editing only your best 
work remains visible.

Step 8. Put the edited photos in a collection. You can do this at any point in the workflow; I 
prefer to add only my final selects, but I know other photographers who put the entire folder 
contents into a collection and do all the editing from within the collection instead of the 
folder. Whichever approach you choose, as you move forward in the workflow, you should 
be spending less time working in folder views and more time working in collections. (Using 
collections is discussed at length later in this chapter.)
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You can do these things in any order you prefer, but you’ll soon discover that some tasks are 
much easier to accomplish if they’re done before or after other tasks. As I frequently remind 
you: try to get in the habit of thinking several steps ahead.

IMAGE SOURCES
All your organizing and editing in Library will be done while previewing various image 
sources. You use these sources to determine which previews are shown as you work with 
your files. In Library, the panels and controls where you can access image sources include:

•	 Catalog panel: built-in sources based on predetermined criteria.

•	 Folders panel: a direct representation of the actual folders on your hard drive.

•	 Collections panel: virtual groups of photos within the Lightroom catalog.

•	 Keywords panel: if a photo has keywords applied, they can be used to define or refine 
other sources.

•	 Filter Bar: filters are used to refine the other image sources and help generate new ones.

These sources are discussed in detail throughout this chapter.

Current and Recent Sources
The Source Indicator is shown in text 
along the top of the Filmstrip (see 
Figure 3–4). This shows the location of 
the current source, as well as the file 
name or number of selected items. 
Clicking anywhere on the current 
source indicator opens the Recent 
Sources menu—you can use this to 
jump to any of the twelve most recently used sources, plus the built-in Catalog sources and 
Favorite Sources (see Figure 3–5). You can clear the Recent Sources list whenever you like. 
Favorite Sources remain even after clearing the Recent Sources.

Combining sources
When you use ⌘+Click or Ctrl+click you can combine multiple sources, even from multiple 
panels. This can help create the exact selection of photographs you want to work on.

Here are a few tips to keep in mind while you’re editing:

Undo/redo: remember that you can always undo and redo steps using ⌘-Z or Ctrl+Z.

Save your work frequently: after each round of editing (but before filtering) select all your 
images and Save Metadata to File by pressing⌘-S or Ctrl+S. This ensures that your ratings and 
any Quick Develop adjustments you’ve applied during editing are saved on disk, in addition to 
the Lightroom catalog. You can learn more about Save Metadata to File later in this chapter.

Rename photos: even if you didn’t rename your photos during the import, you can do so at 
any time. If you’re going to delete photos, it might be best to rename files after the deletions, 
so you won’t have breaks in the sequence numbering. This comes down to personal preference 
but, at some point, it’s a good idea to rename your files to something useful. You’ll learn more 
about this later in the chapter.

Add more keywords as you go: during editing, you should gradually apply more keywords 
to photos that make it through the current round. At the end, your final selects will ideally 
contain a complete, unique set of keywords specific to each individual photo.

Refrain from immediately deleting photos during editing
It slows the workflow; worse yet, you might make a mistake. If you want to delete images, it 
might be best to do it later—better decisions can be made with some time gone by. Plus, in 
Lightroom it’s easy enough to simply hide the photos you don’t want to see. Learn from your 
rejected photos by going back to study them later—you can learn much more from your 
failures than your successes!

Working in Library
Below are the basic tasks you should consider for your “typical” work sessions in Library, in 
general order of importance and sequence in the workflow:

•	 Keep your files organized within your disk-based folder architecture, including naming/
re-naming, etc.

•	 Apply standard metadata, including your name and copyright notice, etc., to everything in 
your catalog

•	 Preview individual photos and groups of photos using different view modes

•	 Identify the best pictures and isolate them from the others

•	 Group photos into logical sets based on your needs and usage (mainly using collections)

•	 Use keywords and filters to find and sort photos

•	 Quick Develop photos as a starting point for more enhancement in the Develop module

•	 Edit video clips

Figure 3-5

Figure 3-4

⌘+Z or Ctrl+Z
Undo
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Library previews
Each module in Lightroom renders its own previews, and they use different settings for 
these previews based on the anticipated needs in that specific module. The Library previews 
are high quality, although not as high quality as previews in Develop. Library previews 
are great for evaluating photos and making editing decisions. In some cases, you may 
see differences in how a photo looks in Library versus how it looks in Develop. (In these 
situations, the Develop preview should be your ultimate guide, as it’s always the highest 
quality preview available based on your current settings.) Previews are also introduced in 
Chapters 1 and 2; for your review, the sizes and quality that Lightroom renders previews are:

•	 Minimal: small thumbnails, relatively low quality.

•	 Standard: the larger preview used 
for Loupe view. The size and quality of 
the Standard previews is set in Catalog 
Settings > File Handling.

•	 1:1: full-resolution previews rendered 
from the actual pixel data of the photo. 
When you zoom in to magnification 
levels greater than 1:1, you’re still always 
seeing the 1:1 preview, which is the 
highest resolution possible.

The time it takes Lightroom to render a 
preview is dependent on the size of the file, 
your computer system hardware and the size 
and quality level specified in Catalog Settings.

Render Previews menu
At any time, you can have Lightroom rebuild 
previews. Go to Library➔Previews and choose 
an option from the menu (see Figure 3–8).

Navigator
As explained in Chapter 1, the Navigator panel 
provides controls for zooming in and out of the 
main preview, as well as an additional preview 
(see Figure 3–9).

Zoom Ratios
Unlike other programs that specify the 
magnification level using a percentage, 
Lightroom’s zoom levels are based on the 
ratio of image pixels to screen pixels. 1:2 is one 
screen pixel to two image pixels. 4:1 is four screen pixels to one 
image pixel, and so on. 

Forward/Back Buttons
At the left of the top part of 
the Filmstrip are buttons to go 
forward and back (see Figure 
3–6). These function very much 
like forward/back buttons 
on a Web browser. During 
the current work session, 
Lightroom keeps track of your location so you can go forward and back between image 
sources as well as switching modules using these buttons.

Catalog panel
The Catalog panel, at the top left of 
the Library module, lists several built-in 
image sources (see Figure 3–7). The core 
criteria used for these Catalog sources 
can’t be changed, but filters can be 
applied to refine them, as discussed later 
in this chapter.

•	 All Photographs: shows all the 
photos in the catalog.

•	 Quick Collection: shows all the 
photos in the Quick Collection.

•	 Previous Import: shows all the photos added to the catalog during the
most recent import.

•	 Other sources on the Catalog panel (sometimes): Depending on the state of 
your catalog and the work you’ve done, sometimes Lightroom will show additional 
sources on the Catalog panel, including Missing Photographs, or Photos Missing from 
[folder name]; Error Photos; Added by Previous Export; Previous Export as Catalog, etc. 
Though these temporary sources come and go automatically, if you want to remove 
any one of these from the Catalog panel, right click its name and from the popup 
menu choose Remove this temporary collection.

Don’t use the Previous Import source for editing
Following an import, switch to the Folder source or make a collection before starting to 
edit the photos. The Previous Import source doesn’t provide the full set of options that a 
folder or collection does, which leads to confusion later in the workflow.

Keep an eye on what’s listed in the Catalog panel
The temporary Catalog sources appear and disappear from time to time and can alert 
you to potential problems, in addition to providing quick ways to retrieve photos you’ve 
recently worked with.

Figure 3-9

Figure 3-8

Figure 3-7

Figure 3-6
⌘+Option+
Left arrow 
or Ctrl+Alt+ 
Left arrow
Go back

⌘+Option+
Right arrow 
or Ctrl+Alt+ 
Right arrow
Go forward
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Use thumbnails for editing
Your initial rounds of editing can primarily be done using thumbnails; they are good 
indicators of strong composition, as you’re not distracted by minute detail as with larger 
previews.

Use the arrow keys to move from one photo to another
In the Library Grid you can move left, right, up and down to select images with your 
arrow keys. At all other times (and in other modules) use just the left and right arrows to 
select the next/previous images shown in the Filmstrip.

NAVIGATING WITHIN THE GRID
When Grid view is active, you have several options for moving around within the rows 
and columns of thumbnails:

•	 Scroll bar: at the right side of the main preview area.

•	 Panning: Position your mouse on the border between thumbnails—the cursor 
turns into a hand and you can scroll the Grid up and down.

•	 Page Up and Page Down: To jump between full-screen sets of thumbnails use 
the Page Up and Page Down keys.

•	 Arrow keys: when you use the arrow 
keys to select photos, pressing the 
down arrow will scroll the entire Grid 
view as you move down past the 
bottom row.

GRID VIEW STYLE
There are two main styles of Grid 
thumbnails: Compact and Expanded (see 
Figure 3–12). Both can be customized using View Options (see Figure 3–16). (There are 
actually two sub-types of Compact cells; one that doesn’t show any extras whatsoever, 
and one with the settings configured in View Options.) Press the J key to cycle through 
the Grid view styles. I almost always work in Grid view using Expanded Cells, set up 
to show a lot of 
information about 
the photos.

GRID TOOLBAR
Each view mode has 
its own Toolbar; the Grid Toolbar is different from that in Loupe view (see Figure 3–13). You 
can add and remove items from the Toolbar using the popup menu accessed with the 
triangle button at the right of the Toolbar. I like to keep just the Painter and Sort tools visible; 
I use keyboard shortcuts for everything else shown in the menu. However, you may find it 
beneficial to also keep the Thumbnail Size slider visible, along with the View Modes buttons.

The available zoom ratios are:

•	 Fit: fits the entire photo into the preview area.

•	 Fill: fills the preview area top-to-bottom with the image. The sides of the photo may 
not be visible.

•	 1:1: maps one image pixel to one screen pixel.

•	 User-selected setting: the fourth zoom ratio uses the most recent custom zoom 
ratio you selected. Clicking this opens a popup menu for you to choose the custom 
zoom ratio.

“You’ll most often use the Navigator panel to set the user zoom level, rather than actually 
zooming in and out using these controls (there are better ways). Zooming in and out of 
previews is discussed in the section on the Loupe view mode.

New in Lightroom 4: the Navigator adds new zoom ratios for 1:8 and 1:16.
These are particularly useful for 
viewing proofs for printing, as 
discussed in Chapters 4 and 9.

Library View Modes
Library provides four view modes, 
each offering a different method of 
previewing photos and videos. You 
can switch between view modes 
using the buttons at the left side of 
the Toolbar (see Figure 3–10)
or with the shortcuts.

Grid view
Much of your work in Library will be done using 
thumbnails of your photos. In Library, the Grid 
view (see Figure 3–11) shows thumbnails inside 
cells arranged in rows and columns. There are 
two parts of the thumbnail: the image preview 
itself and the cell (the gray area surrounding 
a thumbnail). They behave differently and 
provide different options. Thumbnails are useful 
for seeing groups of photos together and 
contemplating their relationships to one another 
and when applying settings to multiple photos. 
Lightroom provides lots of control over the 
presentation and functionality of thumbnails.

Figure 3-13

Figure 3-12

Figure 3-11

Figure 3-10

⌘+= or Ctrl+=
Zoom in

⌘+- or Ctrl+-
Zoom out

G
Grid view

T
Show/hide 
Toolbar

J
Cycle Grid 
view style

+ and -
Increase/
decrease 
thumbnail 
size
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switch between Grid and Loupe views. When 
you’re done changing the settings, close the 
window. The information you choose to show 
depends a lot on personal preferences and 
needs; experiment to find what you like best.

THUMBNAIL BADGES
In Grid view, the default thumbnails show 
one or more small badges when any 
metadata (keywords, cropping, adjustments, 
etc.) has been applied to that image, or if the 
photo is in a collection (see Figure 3–17). Click 
any badge to load the tools for working with 
that kind of metadata.

New in Lightroom 4: there are updated 
badges, including new icons for video clips 
and photos containing gps and map data.

Badges in the Filmstrip
The icons in the Filmstrip can show badges, 
too. Configure this in Preferences➔Interface. 
(Note that some Filmstrip badges won’t show if 
the thumbnails are very small.)

Selections: Choosing the 
photos to work with
Most operations in Lightroom require one or 
more images to be selected. The most obvious 
way to select images is to click them, but there 
are other methods. You can select a single 
image, multiple images or all images in the 
current source. You can also select None (no 
images selected). It’s important to understand 
that most of the time there is at least one 
image selected—if only by default—unless 
you deselect everything.

The Grid and Filmstrip show the same selections. 
Selected photos are highlighted in light gray to 
stand out against the other unselected photos 
(see Figure 3–18). This means that you can select 
images in the Grid, and then see and work with 
those selections using the Filmstrip in other 
modules. The Source Indicator also shows how 
many photos are selected.

Changing Thumbnail Size
You can change the thumbnail size by dragging 
the slider on the Toolbar (see Figure 3–14) or 
using the shortcut (see previous page).

Smaller thumbnails in Filmstrip
Like the other panels, you can resize the 
Filmstrip by dragging its (top) edge. This 
changes the size of thumbnails in the Filmstrip. I usually keep the Filmstrip thumbnails pretty 
small, since I use the Grid view to get more info and don’t need the Filmstrip thumbnails 
to show much detail. The Filmstrip remembers the two most recently used sizes; you can 
double-click the top edge to toggle back and forth.

SORT ORDER: VIEW YOUR 
PHOTOS IN A DIFFERENT 
SEQUENCE
When working in most image sources you 
can change the sort order in which the 
thumbnails are shown. The Library Grid 
Toolbar contains a menu for selecting the sort 
order (see Figure 3–15). The button to the left 
(labeled az or za) reverses sort direction.

User Order
This is a special sort order where you can 
rearrange the thumbnails however you want; 
click and drag with your mouse to rearrange 
the thumbnails in the Grid. This will automatically set the Sort Order menu to User Order. User 
sort order is not available in smart collections, filtered views and Catalog panel sources 
other than Quick Collection.

Drag using the center of the thumbnail image
When selecting or dragging photos, always click on and drag from the image part of the 
thumbnail (not the background of the outer cell area). Otherwise, you’ll only change the 
target photo selection.

Confusing sort order
Image files that get added to the catalog during editing or synchronizing may appear in the Grid 
in an order that can be confusing. If you look for a photo thumbnail in a certain place in the order 
and it’s not there, look at the end of the sort order. Newly added photos (usually with varying file 
types) often end up there. Once you find the new photos at the end, you can modify the sort 
order and/or tag photos differently to control where they appear in the sort order.

GRID VIEW OPTIONS
This window, accessed under View➔View Options (or the contextual menu) configures 
the display of the thumbnails in Grid view (see Figure 3–16). Click the tabs at the top to 

Figure 3-17

Figure 3-16

Figure 3-15

Figure 3-14

Figure 3-18⌘+J or Ctrl+J
View options

⌘+Option+
Shift+H 
or Ctrl+Alt+ 
Shift+H
Show/hide 
badges
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If the Grid shows some empty space 
with no thumbnails at the end, you 
can click there to Select None (see 
Figure 3–21). Otherwise, use the 
menu command or shortcut.

SELECTING & DESELECTING 
MULTIPLE PHOTOS
To add to or subtract from a non-
contiguous selection, hold the ⌘ or Ctrl 
key and click additional thumbnails in 
either the Grid or Filmstrip (see Figure 
3–22). To add a contiguous range of 
photos to a selection, with one image 
selected, hold the Shift key on your 
keyboard and click another thumbnail. 
All the images between the two will 
become selected.

When you have multiple photos 
selected, you can click a photo’s grid 
cell (not the thumbnail preview) to 
deselect all the others while keeping 
that one selected.

With multiple photos selected, to make 
one the target photo, click its thumbnail 
preview (or use the shortcuts).

Select contiguous images 
using the keyboard
In the Library Grid you can quickly 
select images using the arrow keys 
on your keyboard—left, right, up, 
down. Or, in all the modules, you can 
use just the left and right arrow keys 
to move through images horizontally in the Filmstrip. Hold Shift while pressing the arrow 
keys to select multiple contiguous images (those next to each other in the sort order).

SELECT BY FLAG, RATING, COLOR LABEL
Within the current image source, you can use these commands under the Edit menu to make 
specialized selections based on file attributes. (Attributes are covered later in this chapter.)

INVERT SELECTION
These selection commands will invert the selection status of the any photos already 
selected: selected images become deselected; deselected images become selected.

Always know what’s selected
Keep track of your selections at all times. When you’re scrolling in the Grid or 
Filmstrip, it’s possible to have photos selected, but not visible in the preview area. This can 
cause trouble—you could easily apply changes to photos that you didn’t mean to. Pay 
careful attention to which images are selected at all times, and be deliberate in selecting 
and deselecting items.

THE TARGET PHOTO 
(ACTIVE PHOTO)
When multiple photos are selected, the first 
one you selected is the “most selected” and 
referred to variously as the target or active 
photo. The target photo is highlighted brighter 
than the others (see Figure 3–19) and has 
unique properties within the selection. The 
target photo also is used for the histogram, is 
processed in Develop; and contains settings 
that can be synced (or copied and pasted) to 
other images. Most importantly, the target 
photo behaves as if no other images were 
selected.

The order in which multiple photos are selected 
is important, because it determines the target 
photo. By default, when you switch between 
image sources, the first image in the source 
becomes active. With multiple images selected, 
the first one selected becomes the target photo.

SELECT ALL
There are many situations where you will want 
to select all the images in the current source, 
such as when adding to a collection, modifying 
keywords and Saving Metadata to File. Use the 
Select All command under the Edit menu, or use 
the shortcut. All images in the current source 
become selected (see Figure 3–20). If you had an image selected before running the Select All 
command, it becomes the target photo. If no image was previously selected, the first image in 
the source order becomes the target photo.

SELECT NONE
This is one of the most important commands used throughout the editing 
workflow. It’s a very good habit to deselect any previously selected images before 
moving on to work on others. Otherwise, you might accidentally apply adjustments or 
other changes to a photo without intending to!

Figure 3-21

Figure 3-20

Figure 3-19

Figure 3-22

⌘+A or Ctrl+A
Select all

⌘+D or Ctrl+D
Select none

⌘+Option+A or 
Ctrl+Alt+A
Select Picks
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Examples: many landscape photographers often capture a sequence of photos, all with 
the same composition, with only the light in the scene changing over time. Or a portrait 
photographer might have a series of shots that all have very minor differences in the pose 
of the subject. By stacking these kinds of shots together, you can simplify the Grid view, 
significantly reducing distractions during editing. Later, when you’re ready to choose the 
champion shot (the winner between several competing images) you can expand the stack 
to finish editing those photos. Then, when you’re done choosing the final selects, you can 
unstack the photos, or move the champion to the top of the stack and collapse it again.

There are a couple of important limitations to stacking: stacks are not available in 
Catalog panel sources, smart collections or filtered views, and a single photo can only be a 
member of one stack. If you try to make a stack and it doesn’t work, it’s likely because the 
current source doesn’t allow stacking, or because one or more of the selected photos already 
belongs to another stack.

New in Lightroom 4: stacks can 
now be used in regular Collections, 
even if the files are in different 
folders.

A stack can be collapsed, which 
will then only show the thumbnail 
for the top photo, or expanded to 
show all the photos in the stack (see 
Figures 3–24 and 3–25).

Stack photos and videos
Choose Library➔Photo 
menu➔Stacking➔Group into Stack, 
or use the shortcut. The target photo 
will go at the top of the stack by 
default, but you can change the 
stacking order at any time afterward. 
The top image in a stack shows the 
photo count for the stack in the 
upper left corner of the thumbnail. 
Click this to expand and collapse the stack. Right-click or Ctrl+click on 
the stack photo count badge to open the stack contextual menu.

Filters and stacks
When filters are applied (see later in this chapter), unflagged and unrated images within a 
stack might be hidden, which can really cause confusion. To avoid this, make sure all the 
photos in a stack are marked with the same attributes (discussed later in this chapter).

Changing the order of images within the stack
To change the order of images within the stack you must first expand it. Click the photo 
count badge or the two thin lines at the right edge of the top image in the stack. Use the 

ADD, SUBTRACT, INTERSECT
These specialized selection commands allow you to make complex photo selections 
quickly based on several criteria. These selections commands are Boolean; think of them 
in terms of yes/no, on/off or active/inactive. You can start with one selection and then 
modify it to include only the images you want.

Rotating and flipping photos
You can rotate and flip images when viewing either Grid thumbnails or Loupe previews. 
Remember that this only affects the previews in Lightroom; the original file on disk is 
not altered. However, when you save metadata to the file, the rotation will be visible in 
other programs supporting xmp, and when you export new files from photos rotated in 
Lightroom, the exported images will be rotated.

ROTATING PHOTOS
In Grid, the thumbnails can show arrows for rotation 
(see Figure 3–23). (View Options lets you configure 
this to show the rotation arrows all the time, or 
just when your cursor is over a thumbnail.) Click 
the arrows to rotate the photo(s) by 90-degree 
increments. If you have multiple photos selected, 
you can rotate them all at once. (To rotate an image 
by an amount other than 90 degrees, use the Crop/
Straighten Tool in Develop; see Chapter 4.)

Select all photos of a specific orientation
You can use filters to select all the photos of 
either a Landscape or Portrait orientation. (In the filters, it’s referred to as “aspect ratio”, 
though this is a bit of a misnomer.) Filters are discussed later in this chapter.

FLIPPING PHOTOS
Photos can be flipped around their horizontal and vertical axes. To flip images in Library, 
select the photos to be flipped, and choose the menu command Photo➔Flip Horizontal 
or Photo➔Flip Vertical.

Enable Mirror Image Mode
Under the View menu is an option for Enable Mirror Image Mode. This is a global setting 
affecting all previews in the catalog. When it’s enabled, all the previews are mirrored 
horizontally. This might be useful for some presentation setups, or when you’re showing 
people portraits of themselves (since we’re used to seeing ourselves in a mirror), or 
possibly when working with flipped scans or photos taken in a mirror. (My guess is that 
you’ll rarely—if ever—use this feature.)

Stacks: Grouping items together
Think of stacks like sets of film slides: you can stack photos “underneath” each other, so 
that only the “top” photo is visible in the Grid. Stacks save space in the Grid, and can be 
useful when you’ve shot a sequence of similar images and want to group them together. 
Stacking photos of related subject or composition can save time during editing.

Figure 3-25

Figure 3-24

Figure 3-23
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arrow keys to select the image you want to reposition and use the stack contextual menu 
commands (or the keyboard shortcuts, not shown) to move the image within the stack.

Auto stack by capture time
First, choose a folder, then right-click or Ctrl+click on one of the thumbnails. From the 
contextual menu, choose Stacking➔Auto Stack by Capture Time. Set your desired time 
interval by adjusting the slider; the number of stacks that will be created will show 
underneath. Press Return or Enter. Lightroom will create stacks in the current source 
for all photos matching the given criteria.

New in Lightroom 4: you can now set Auto Stack by Capture Time to 0 seconds,
which will stack photos taken in the same second.

Loupe view
Loupe view displays 
a single, large photo 
(see Figure 3–26). 
You can zoom 
in and out of the 
Loupe preview 
using preset zoom 
levels based on ratios 
of image pixels 
to screen pixels. 
When the image is 
magnified you can 
pan the image to 
examine different 
parts of it more 
closely.

The full screen image shown in Loupe view uses the Standard preview size. If you zoom 
in to 1:1 or greater, Lightroom will load the 1:1 preview. When you first enter Loupe view 
or zoom in close to a photo, Lightroom may need to build the preview. If this is the case, 
you’ll see a message at the bottom of the image that says Loading…. This will take varying 
amounts of time depending on the size of the preview being built.

ZOOMING IN AND OUT
Lightroom gives you several ways to zoom in and out of images. Each method has its own 
usefulness; in some situations, one way is easier or faster than the others, so it’s worthwhile 
to learn all the methods for zooming.

To show an image full size in Loupe view, double click a thumbnail, or press E or Return/
Enter. To go back to Grid view, double click again, or press G. Pressing Return/Enter cycles 
through Fit/Fill, most recent zoom and Grid.

To zoom in closer, use the Navigator panel zoom selectors, the Toolbar slider or the 
keyboard shortcuts. Using the shortcut zooms in and out based on the four zoom 
levels shown on the Navigator, discussed earlier in this chapter and in Chapter 1.

Click-release versus click-hold
You’ve probably already figured out that you can click the Loupe preview to zoom in 
and out with each click. Try this, too: click and hold the mouse button to zoom in, and 
without letting go, drag the hand tool to move around the preview. Then release the 
mouse button to zoom back out to the previous view.

Zoom clicked point to center
There is a preference setting that re-centers zoomed images around the clicked zoom 
point. I find this useful most of the time. Go to Preferences➔Interface➔Tweaks.

PANNING A PHOTO’S LOUPE PREVIEW
When you’re in any zoom ratio except Fit, you can 
pan around the image by clicking and dragging 
with the hand cursor (see Figure 3–27).

Scrolling the Loupe previews with 
Page Up and Page Down
Tapping Page Up and Page down on your keyboard 
allows you to “scroll” over a Loupe preview in equal 
“columns” whose widths are determined by the 
zoom ratio and the width of the Loupe preview. Start 
at the top left of the image, and press Page Down 
repeatedly. When you’ve reached the bottom of the 
photo and you press Page Down again, Lightroom 
will jump the preview to the top of the next column 
to the right. This is very useful when checking photos 
for artifacts and doing retouching such as removing 
dust spots, as it ensures you can see every part of the 
photo, which can be uncertain using only manual 
panning. If you have the Caps Lock key active on your 
keyboard, the scrolling goes horizontally.

LOUPE INFO
Lightroom provides optional text overlays that show 
the specs of the image file, capture settings and other 
useful information (see Figure 3–28). Press I to cycle 
through the overlays. Using View Options (under the 
View menu in the main menu bar), you can configure 
the elements making up the info overlays.

New in Lightroom 4: There are some new elements available to add to the overlays, 
mainly having to do with file names and copy names, in support of virtual copies and 
the new Soft Proofing features.

Figure 3-26

Figure 3-28

Figure 3-27
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Choosing a file for the overlay
You first need to make a graphic 
file in Photoshop or another 
similar program. The file must 
be saved as a png; other formats 
are not supported. png files 
can contain transparency, so if 
you use layers and transparent 
elements in your layout, they will 
be preserved in the png. (For this 
to happen, you must save the 
file in png-24 format; you can do 
this with Save for Web & Devices 
in Photoshop.)

Then, to activate the Layout 
Overlay, go to View➔Layout Overlay➔Choose Image 
(see Figure 3–33) or use the shortcut. Select the 
image file from your hard drive and click Choose.

Adjusting the overlay
The Layout Overlay will appear in the Loupe view 
(see Figure 3–34). You can hold the ⌘ or Ctrl key to 
manipulate the overlay. With the ⌘ or Ctrl key held 
down, click and drag to move the overlay where you 
want it. Click and drag the corners of the overlay to 
resize it. When holding the ⌘ or Ctrl key, controls 
appear at the bottom of the overlay for Opacity 
and Matte (see Figure 3–34). Opacity controls the 
transparency of the overlay itself; matte darkens the 
preview around the outside of the overlay. Click and 
drag horizontally over each control to 
change its value.

Lights Out with different colors
In Preferences➔Interface you 
can change the color used for 
Lights Out; this can be a nice 
complement to the Layout 
Overlay matte in helping 
visualize mockups.

Hiding the overlay and 
removing the image
You can show and hide the 
overlay using the command 
under the View menu or the 

LOUPE TOOLBAR
The Loupe view mode 
has a separate Toolbar 
from the Grid view (see 
Figure 3–29). You can 
add and remove items 
from the Toolbar using the popup menu accessed with the triangle button at the right of 
the Toolbar. For the Loupe Toolbar I keep the Attributes visible (Flagging, Rating and Color 
Labels) so I can easily see what’s applied without switching to another view mode. The 
Zoom slider can come in handy, too, but I usually use the keyboard shortcuts to zoom in 
and out of the Loupe preview. (Note: All the items on the Toolbar might not be visible if 
the preview area is very small.)

LOUPE VIEW OPTIONS
This window, accessed under View➔View 
Options configures the display of the Info 
Overlays in Loupe view (see Figure 3–30). 
Click the tabs at the top to switch between 
Grid and Loupe views. Use the provided 
options to set up the info overlays with the 
elements you prefer. When you’re done 
changing the settings, close the window.

LOUPE BACKGROUND COLOR
You can change the color of the background 
area surrounding the standard Loupe 
preview (see Figure 3–31). Right-click or 
Ctrl+click in the background area (you have 
to be zoomed out for this) and choose a color 
from the popup menu.

LAYOUT OVERLAY
New in Lightroom 4: the Layout Overlay 
allows you to place a png file from your hard 
drive into the Loupe preview (see Figure 3–32). 
This feature is designed to help you visualize 
how a photo will look when placed into a 
specified layout, for example, a magazine cover 
or wedding book layout. You can bring in a 
png file containing transparency, and it shows 
“on top” of the photo, allowing you to confirm 
position of elements in your composition. 
Layout Overlay can be especially helpful with Tethered Capture (which is covered in Chapter 2), 
but you can use it any time you want to see how a photo looks with a particular layout.

Figure 3-34 Photo © Jim Talaric

Figure 3-33

Figure 3-32 Photo © Jim Talaric

Figure 3-31

Figure 3-30

Figure 3-29
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Survey
Survey view is for 
comparing more than 
two images. All the 
selected images are scaled 
automatically to fit into the 
Survey window (see Figure 
3–38). (For typical display 
sizes, I think Survey is most 
useful with a maximum of 
8-10 images; with more 
than that, you’re probably 
better off using the Grid 
with a large thumbnail size 
and the panels hidden.)

To enter Survey view, select multiple images from the Grid or Filmstrip and click the Survey 
button on the Toolbar, or press N. Note that the photos you see in Survey are all selected, so 
as when working with any group of multiple photo selections, it’s important to keep track of 
the target photo. In Survey, the active (“most selected”) photo is indicated by a white outline. 
Clicking a photo makes it the target photo.

Once in Survey view, you can add, remove or rearrange the previews. Drag a preview to put 
it in a different position; this also changes the Grid and Filmstrip sort orders. Remove a photo 
from Survey by clicking the X in the bottom right corner of the photo (you must put your 
cursor over the images to see the controls). Add photos to the view by selecting them from 
the Filmstrip while holding the ⌘ or control key. Press / (forward slash) to remove a selected 
photo from the Survey selection.

Hide the Toolbar for more room
Press T to hide and show the Toolbar. I usually hide the Toolbar in Survey view, but there are 
times when the Toolbar is helpful, or even necessary, to perform certain tasks. In all modules, 
don’t forget to frequently check the Toolbar visibility. You can either make more room for 
photos by hiding it, or show it to provide access to more controls—some of which are not 
found anywhere else in Lightroom. 

Using the Secondary Display with Library
As introduced in Chapter 1, Lightroom offers support for a secondary display that can be 
configured separately from the main window. The second window can be used to show full-
screen Loupe images while you choose from thumbnails in your main window, or vice versa.

You can also use the second window for Compare and Survey views, while keeping your main 
window in another view. (With this setup, if you have a large enough display, you can benefit 
from the second window, even using it on a single screen.)

shortcut. To use another image, just choose the new one from your hard drive. Lightroom 
remembers the location of the file you selected; if you want to remove it entirely, move, 
delete or rename the png file. When Lightroom can’t find the file, it will be automatically 
removed from memory.

Compare
Compare view lets you evaluate 
two images side by side (see Figure 
3–35). Select two photos and 
click the Compare button on the 
Toolbar, or press C. The target photo 
becomes the select and the second 
image becomes the candidate. 
When you enter Compare view, 
first take a look at the Toolbar; you’ll 
notice some added controls for 
working in Compare. In Compare 
(and Survey) view it’s helpful to hide 
the panels to allow maximum room 
for the images. Also, you can use Lights Out to dim or black out the entire screen except 
for the images. (The figure shows Lights Out using white.)

CHANGING PHOTOS IN THE 
SELECT AND CANDIDATE 
POSITIONS
The Toolbar in Compare view contains 
buttons for switching or swapping 
photos in both select and candidate 
positions (see Figure 3–36). Hover over each button to see its tool tip.

Left and Right Arrow Keys
With two images loaded in Compare view, use the left and right arrow keys to load the 
next photo in the current source or selection into the Candidate position (see Figure 
3–36). Tapping the up arrow promotes a candidate photo to the Select, simultaneously 
making it the target photo.

LINK FOCUS
With Link Focus, you can zoom 
into the exact same place on both 
images to check for critical focus, 
examine small details, etc. Make 
sure the Toolbar is visible, and click 
the lock icon to enable Link Focus 
(see Figure 3–37). You can then 
zoom in and out and pan both 
images at the same time.

Figure 3-38

Figure 3-37

Figure 3-36

Figure 3-35
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Resize the panels
Drag the edge of the 
left panel set to make 
it wider; this will 
show longer folder 
names. On Mac, 
hold the Option key 
when dragging the 
panel edges to make 
them much wider (see 
Figure 3–42).

HARD DISK 
DRIVES AND 
VOLUMES
At the top level of the 
folder/file hierarchy is the volume. A volume is usually 
an individual hard disk drive, but could also be a 
partition on a single disk or a multiple-disk array.

Volumes (and folders) shown in Lightroom 
correspond directly to the drive volumes on your 
computer’s file system (Mac os x Finder or Windows 
Explorer). Volumes are listed in the Folders panel 
with their folders underneath (see Figure 3–43).

A single Lightroom catalog can contain images from any number of volumes. As you import 
images from folders on different drives, each volume also automatically gets added to the list in 
the Folders panel. Each volume has its own Volume Browser listing, which shows the status of 
the volume and optional statistics. Click the volume name to hide and show its folder contents.

Volume browser information
By default, the Volume Browser also shows the 
available free space and the volume size. This can 
be changed. Normally there’s a green “light” at the 
left of the Volume Browser indicating the volume 
is online with available free space. If the light is 
yellow or red, free space on the volume is low. If 
a volume is dimmed (gray), that volume is offline. 
To change the Volume Browser display options, 
or to show the volume in the Finder or Explorer, 
right-click or Ctrl+click on the Volume Browser 
header (see Figure 3–44) and choose the information you’d like to show.

Root Folder Display options
To change the details shown on the root folder, click the + button at the right of the Folders 
panel header (see Figure 3–45). From the menu, choose the options you prefer.

Figure 3-44

Figure 3-43

To open the secondary display, click the button on 
the top left of the Filmstrip (see Figure 3–39). At 
the top left of the second window are the same 
view modes as the main window: Grid, Loupe, 
Compare and Survey (see Figure 3–40).

LIVE LOUPE
At the top left of the second window, choose 
Loupe. At the top right, choose Live (see Figure 
3–40). Move your cursor over the thumbnails in 
the main window and the second window will 
instantly show each photo under the cursor.

LOCKED
Locked mode retains the same image until you 
explicitly choose to update it. This can be helpful 
in client reviews, as you can push images to 
the second display only when you intend to. At 
the top left of the secondary display window, 
choose Loupe. At the top right, choose Locked 
(see Figure 3–40). Right-click or Ctrl+click on a 
thumbnail for the contextual menu and choose 
Lock to Second Window.

Folders panel: Work directly 
with folders on your hard drives
The Folders panel (see Figure 3–41) shows the hard disk 
and directory structures for all the photos that have been 
imported into Lightroom. Folders are the essential system 
for organizing your photos on the hard disk; when you 
import a photo into Lightroom, the folder containing that 
photo will also be added to the Folders list. (By default, 
parent folders above the added folder are not shown, so 
you don’t always see the complete directory structure, but 
you can change this.)

Once photos have been imported, it’s best to 
manage them entirely from within Lightroom. This 
ensures that Lightroom can keep track of the files. You can 
directly manipulate the folders on disk from within the 
Folders panel. For example, if you move or rename folders 
in the Folders panel, those changes will also be made to 
the folders on disk.

Unlike the windows and folder views in Mac Finder and Windows Explorer, the Folders 
panel does not show image files. As you select folders by clicking on them, their contents 
are shown in the view mode previews and in the Filmstrip.

Figure 3-42

Figure 3-41

Figure 3-40

Figure 3-39
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Offline/online
A disk volume that is connected and 
available to the computer is online. 
A volume that is not available to the 
computer is offline. You can’t work 
on images from offline volumes in 
Develop, and a few other controls 
become unavailable. This is because 
when processing an image, Lightroom 
renders new previews after each 
change is made, which requires re-reading the data from the file on disk. (However, in 
many cases you can work with photos from offline volumes in Library and the output 
modules, where Lightroom will use rendered previews if they are available.)

Offline volumes are dimmed in the Folders panel. You can still navigate within their folder 
structures, although all the folders and photos will show as missing.

Volumes not listed in the Folder panel
Lightroom will not show or provide access to a 
volume until you import photos from that drive. 
If a drive is connected to your computer but 
its volume is not listed in the Folders panel, it’s 
because no photos from it have been imported 
into the current catalog. (This is one easy way to 
verify you’re working in the correct catalog.)

FILE COUNTS
At the right of each folder name a number is 
displayed showing how many items from that 
folder have been imported into the catalog 
(see Figure 3–46). If you’ve imported everything 
from the folder, this file count should be identical 
to what you’d see in Mac Finder or Windows 
Explorer. If a folder in the list contains no photos 
indexed by the catalog, this will display 0.

SHOW PHOTOS IN SUBFOLDERS
When the Show Photos in Subfolders menu 
option is active, selecting a folder in the Folders 
panel will show its contents and also the 
contents of any subfolders it contains (see 
Figure 3–47).

Though this is the default condition, 
depending on your folder structure, this may 
be neither necessary nor desirable. With 
photos in subfolders shown, it can be difficult 

to determine exactly which folder contains the selected photos—the photos will 
be shown when you select the parent, even though they are actually contained in 
a different folder underneath (see Figure 3–46). Also, showing all the contents of 
subfolders can slow Lightroom’s performance as it reads and makes previews for the 
many files in the subfolders. Usually, I think it makes more sense to just load the photos 
actually contained within the single folder I selected.

You can enable or disable this 
option from the menu that appears 
when you click the + button on 
the panel header. With the Show 
Photos in Subfolders option turned 
off, and you select a parent folder 
with no photos contained within it, 
by default you will see the message 
“No photos in selected Folder. 
Subfolders not shown.” Selecting 
a folder from the panel will only 
display the contents of that folder 
and not of any subfolders (see Figure 3–48). This gives you a much more accurate 
view of the exact contents of each individual folder and can speed up previewing when 
switching between folders. A potential drawback to doing this is that the file counts of 
parent folders are also affected (see Figure 3–48).

I normally work with Show Photos in Subfolders turned off, and only turn it on 
temporarily as needed.

FINDING A FOLDER ON 
YOUR HARD DRIVE
Depending on what you’ve imported, the 
contents of the Folders panel may or may not 
clearly reveal the complete directory path where 
the folder is located. If you ever have a question 
about where the folder resides on disk, or need 
to quickly go to it in the Mac Finder or Windows 
Explorer, you can easily locate a folder anywhere 
on your hard disk: right-click or Ctrl+click on the 
folder name; from the contextual menu choose 
Show in Finder or Show in Explorer. This will 
locate the folder and select it in the file system 
(see Figure 3–49). Note that when you run this 
command with multiple folders selected, the 
uppermost folder in the list is the one that will 
be shown in your file system.

Figure 3-49

Figure 3-48

Figure 3-47

Figure 3-46

Figure 3-45
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RENAMING FOLDERS
Renaming a folder from Lightroom also renames the 
folder on disk. Right-click or Ctrl+click on the folder 
name, then choose Rename from the contextual 
menu (see Figure 3–50). Type the new name and 
press Return or Enter.

MOVING FOLDERS
You can drag and drop to move folders in the 
Folders panel. When you move a folder from within 
Lightroom, it gets moved on the hard drive. Click 
and drag a folder from one location to another and 
a dialog box appears for confirmation (see Figure 
3–51). While holding the control key, you can select 
multiple folders and drag them all at once.

Moving folders from one 
hard drive to another
When you move folders between volumes, 
Lightroom performs a file copy in the 
background, and once the copy from one 
drive to the other is complete, the folders 
and files are deleted from the first drive.

ADDING SUBFOLDERS
When you create a new subfolder from within 
Lightroom, it is also created on your hard disk. To add 
a subfolder, right-click or Ctrl+click on a folder in the 
list and select Create Folder Inside… (see Figure 3–52) 
or click the + button on the Folders panel header and 
choose Add Subfolder (see Figure 3–53). Type the folder 
name for the new folder and press Return or Enter. The 
new, empty subfolder will be placed inside the folder 
currently selected in the Folders panel.

ADDING FOLDERS
When you add an existing folder from 
your hard drive, you are taken to the 
Import window set to the Add import 
method (see Chapter 2 for details on this). 
To add a folder, click the + button on the 
Folders panel header, and then choose 
Add Folder (see Figure 3–53). Complete 
the import from within the Import 
window, as described in Chapter 2.

REMOVING FOLDERS
When removing a folder from Lightroom, if it contains photos, the folder will be removed from 
the catalog but will remain on the hard drive with all its contents intact. When you remove an 
empty folder from the catalog, it’s sent to your system trash immediately, without confirmation. 
Removing parent folders also removes any subfolders contained within it. To remove a folder, 
right-click or Ctrl+click on the folder name and choose Remove Folder from the contextual 
menu, or click the – button on the panel header. Press Return or Enter to confirm the removal.

Removing folders deletes catalog data
When you remove a folder from the catalog, all the information about the contents of that 
folder—including Develop adjustments, virtual copies and any other metadata—is also 
immediately removed from the catalog. If you make a mistake, you can usually Undo this 
with the command under the Edit menu. However, if you quit Lightroom, when you come 
back later the removed data will not be recoverable.

MISSING FOLDERS AND WHAT 
TO DO ABOUT THEM
If a folder name contains a question mark (see 
Figure 3–54) it means the folder (and its contents) 
cannot be located by Lightroom. If you know for 
sure that you don’t need that folder, you can simply 
remove it from the catalog using the methods 
above. However, if you want to keep the files, and 
Develop or Export any of the contents of a missing 
folder, you will first need to locate it.

If you know the location of the missing 
folder, right-click or Ctrl+click on the folder 
name and choose Find Missing Folder from 
the contextual menu (see Figure 3–55). 
Navigate through the system dialog boxes 
to find the missing folder and click Select 
Folder to finish. Lightroom will update the 
links in its catalog.

If you don’t know the location, you can’t relink the folder. It’s possible the folders were imported 
from a hard drive that is not currently attached to the computer; verify the drive is attached.

Be careful when removing folders, especially those that show as Missing—make sure you 
have figured out why they’re showing as missing before you remove them.

COMMANDS FOR MANAGING FOLDERS IN THE PANEL
There are numerous commands that will help you manage the contents of the Folders 
panel. Right-click or Ctrl+click on a folder, and choose an option from the popup menu (see 
Figure 3–56). (Many of these commands are explained in task-based context throughout the 
preceding sections.)

Figure 3-54

Figure 3-53

Figure 3-52

Figure 3-51

Figure 3-50

Figure 3-55
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Move Selected Photo to This Folder
If you have one or more photos selected, 
this command appears, allowing you to 
move those files from their current folder 
to the folder you right-clicked on. This 
does the same thing as drag and drop.

Create Folder Inside…
Creates an empty subfolder under the 
selected folder.

Rename…
Allows you to rename the selected folder.

Remove…
Removes the selected folder (and all its 
contents) from the Lightroom catalog (see explanations in previous section).

Hide this Parent
Use this command to remove a parent folder from the catalog; the subfolders will remain. 
(In earlier versions of Lightroom this was called Promote Subfolders.)

Be careful hiding parent folders
When you hide parent folders, if they contain photos, those photos are immediately 
removed from the catalog, and all the data about them is deleted. To get them back you’d 
need to re-import them.

Show Parent Folder
To add the parent folder of the selected folder to the Folders panel, right-click or Ctrl+click 
the folder name, and then choose Show Parent Folder. The parent folder containing the 
selected folder will be added to the folders panel. However, if that folder contains photos, 
they are not automatically imported. (In earlier versions of Lightroom, this was called Add 
Parent Folder; it does the same thing.)

Save Metadata
Saves the Lightroom metadata to disk for all the files contained in the selected folder.

Synchronize Folder…
Opens the Synchronize Folder dialog box, which allows you to sync the contents of the 
Lightroom catalog with the contents of the folder on the hard drive. Synchronize Folder is 
explained in detail later in this chapter.

Update Folder Location…
This command allows you to point Lightroom to a different source folder on a hard 
disk, whether or not Lightroom thinks a folder is “missing”. This is useful if you’ve copied 
or moved files and need Lightroom to use the new location, even though the existing 
catalog links are not broken.

Import to this Folder…
Provides a quick way to import photos into a specific folder. Right-click or Ctrl+click on a 
folder and select the command from the menu. The Import window opens with the chosen 
folder as the destination.

Export this Folder as a Catalog…
Creates a new catalog, using the contents of the folder, and saves the files to 
your hard drive. Exporting as catalog is covered in Chapter 11.

Show in Finder (or Show in Explorer)
Selects the folder in your computer file system.

Get Info (or Properties)
Opens the system dialog box to display information about the folder on disk.

Managing photos and video files in Library
After photos and videos have been imported into a Lightroom catalog, those image files need 
to remain accessible to Lightroom for you to do most of the work with them. For example, you 
can’t do any Develop edits without having the actual files accessible by Lightroom. You can do 
metadata edits like keywording, rating etc. but if you want to actually process the files you need 
the original image files available on disk. When 
you have access to the actual files, renaming or 
moving photos in Lightroom also makes those 
changes to the files on disk.

FINDING A PHOTO IN THE 
LIGHTROOM FOLDERS LIST
Occasionally, when working in a source other 
than a folder you may need to find the folder 
that contains the file within the catalog. 
Right-click or Ctrl+click on the photo, and 
from the contextual menu choose Go to 
Folder in Library (see Figure 3–57).

FINDING A PHOTO ON YOUR HARD DRIVE
From within the Lightroom catalog, you can easily locate an image file anywhere on your 
hard disk. Right-click or Ctrl+click on the photo. From the contextual menu choose Show in 
Finder or Show in Explorer; this will locate the image within your hard drive’s file system. 
Note that when multiple photos are selected this menu option is unavailable.

MOVING PHOTOS
To move photos and videos from one folder to another, simply select their thumbnails and move 
them from one folder to the other using drag and drop (or use the popup menu command 
on the destination folder). Be sure to click and drag from the central thumbnail portion of the 
preview, not the outer cell area, or you’ll just change the target photo selection. You’ll receive a 
confirmation dialog box reminding you that you’re actually moving the files on disk.

Figure 3-57

Figure 3-56

⌘+R or Ctrl+R
Show in Finder or 
Show in Explorer
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Splitting folders
If you want to separate the contents of one folder into separate folders, simply create the 
new subfolders in the list at the location where you want them, and move the photos into 
those new folders using one of the methods described above.

RENAMING PHOTOS
One of Lightroom’s most useful batch processing capabilities is renaming files. Renaming 
photos in Lightroom also renames the image files on disk. Renaming files is something 
you should consider carefully and do early in the workflow.

To rename a single file, you 
can simply change the name 
in the File Name field on the 
Metadata panel. To rename a 
batch of files, use the Rename 
Files menu command, or the 
shortcut, to open the Rename 
Files dialog box (see Figure 
3–58). From here, you can simply select Custom Name from the File Naming drop-down 
menu and enter whatever text you like for the name in the Custom Text field. Lightroom 
will use your custom text for the new names and automatically append a sequence 
number at the end of each file name. Or, you can use one of the other file naming 
templates for more control over the names.

File naming templates
Using file naming templates, you can set up 
file names using whatever conventions you 
prefer. The templates can then be used to 
rename files in the Library module as well as 
during imports and exports. To access the 
Filename Template Editor (see Figure 3–59), 
choose Edit from the File Naming menu on 
the Rename Photos dialog box. (You can also 
access the filename template editor from the 
import window; see Chapter 2.)

The filename template editor provides controls 
to set up your template. Your template 
can contain a combination of set text and 
tokens— a token is a preformatted container for automatically inserting different types 
of information, such as date, sequence number, etc. You can type directly in the text box 
and/or click the Insert buttons to put tokens in the name. Choose the tokens and text you 
want to form your new naming template, referring to the preview of the name above the 
box. When it’s the way you want it, save the template from the Preset menu at the top.

New in Lightroom4: Lightroom 4 includes some new default file naming templates.

Rename a batch of images after editing the shoot
If you do your file naming in Library, rename the photos after you remove any rejects—this 
will keep your numbering sequence unbroken.

DELETING PHOTOS AND VIDEOS
You can remove images from Lightroom without affecting them on the hard disk, or you 
can use Lightroom to actually delete files from the disk. Select the image(s) and press 
Delete. A dialog box appears giving you three options (see Figure 3–60):

•	 Delete from Disk: Remove the 
photo(s) from the Lightroom 
catalog and put the image file 
in the system trash.

•	 Remove: Remove the photo(s) 
from the Lightroom catalog but 
leave the image on the disk. (You won’t be able to work with the photo 
in Lightroom any more, unless it’s re-imported later.)

•	 Cancel and do nothing.

Be very careful when deleting photos
When you delete photos from Lightroom, any edits or adjustments you made to those 
photos in Lightroom will also be removed. If you haven’t saved out the metadata, that 
work will be lost. (You could re-import the files, but your Lightroom changes will not be 
restored.) If you make a mistake when deleting photos, you can immediately Undo the 
deletion(s) using the command under the Edit menu (unless you used Delete from Disk).

Delete Rejected Photos
If you use Reject Flags, you can use Photo➔Delete Rejected Photos to quickly remove all 
the rejects from the current source. Flags are discussed later in this chapter.

Extract previews
If you’ve deleted photos from disk and they are unrecoverable, as a workaround you can 
extract Lightroom’s previews to create new files. This will depend entirely on the size and 
quality of the previews that were in existence prior to the time the photos were deleted, 
but in most all cases the extracted previews will be nowhere near the size or quality of 
the original photos. But in an emergency, having the extracted previews might be better 
than nothing at all! To extract the Lightroom previews you could use Print to File with Draft 
Mode Printing (in the Print module, see Chapter 9), or try a new Extract Previews utility 
designed by Adobe for this purpose. See the Appendix for links.

MISSING PHOTOS AND WHAT TO DO ABOUT THEM
Remember that the names and locations of your image files are recorded in the catalog 
during import. This means if you move anything in your file system outside Lightroom, 
especially when Lightroom is not running, the catalog will not automatically update and 

Figure 3-60

Figure 3-59

Figure 3-58

Delete or 
Backspace
Delete selected 
photo(s)

F2
Rename 
photo(s)
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Windows drive letters
In some situations, it’s possible that the files haven’t actually been moved, but Lightroom has 
lost track of them. This can happen when using an external drive on Windows, where the drive is 
assigned a drive letter each time it’s turned on. It’s possible that the same drive will be assigned a 
different drive letter each time it’s connected. In these cases, Lightroom won’t be able to find the 
files, because the drive letter is part of the file path stored in the catalog. There are several ways to 
permanently set drive letters on Windows; search online to find the best option for you.

FIND MISSING PHOTOS
This command, under the Library menu, identifies missing photos in your catalog and filters 
the Library view to show them. You can then determine whether to relink or delete them.

Don’t leave broken links hanging around
If you have missing folders or photos showing in your catalog, you should either relink them or 
remove them as soon as possible. Catalog housekeeping is essential! When using any database-
enabled program (like Lightroom) it’s important to keep the database as clean as possible, with 
no extraneous data or records known to be bad. This will make things easier to find, improve 
performance, speed backups and generally make the program more enjoyable to use.

Cleaning up your photo archives
When you first start working with Lightroom, you might very soon realize that your files and 
folders are a real mess—I certainly found this out the hard way. Getting your photo and video 
library organized—and keeping it that way—is an unpleasant but vitally important aspect of 
being a digital photographer. Most photographers must tackle this problem themselves—
unless you’re fortunate enough to have assistants manage your digital archives, effective file 
management is a skill set you absolutely must develop.

First, you need to create and adopt a good system, starting now. Second, you need to decide 
whether or not to go back and rework your existing archives to conform to the new standards. 
(I did.) If you decide to clean everything up, take it one small bit at a time. If you try to do 
too much all at once (like I did) you may also find out part-way through the process that you 
overlooked an important piece of the puzzle.

If you have large numbers of files in your historical archives that you don’t feel deserve your 
taking the time to reorganize or change names, don’t worry too much about it right now. The 
most important thing is to nail down a system and use it going forward. After you’ve lived with 
it for a while, you can decide if anything needs reworking and if older files should be renamed 
and reorganized in different folders to fit the new conventions.

You can use the recommendations from this book as a starting point. Figure out how you want 
to structure your hard drives and folders, with a plan for future expansion. Lock down your 
naming convention (easier said than done) and, above all, try to be consistent in your methods 
and diligent in your efforts. It pays off—big time—as your library grows to contain many tens 
or hundreds of thousands of images.

the files will show as missing. Photos will show as missing if they’ve been moved or 
renamed outside Lightroom or if their folder has been moved or renamed—you will need 
to relink the files from within the catalog. Photos will also show as missing if the drive is 
turned off or disconnected. Whatever the reason, if Lightroom can’t locate a file or folder, 
you’ll receive various types of notifications about this, such as questions marks on the 
thumbnails and error messages in Develop. The most common causes and solutions for 
broken links include:

•	 The file or folder was moved or renamed outside Lightroom: re-locate the files 
from within Lightroom or put things back the way they were.

•	 The volume is offline: connect the hard drive(s) to the computer.

•	 Something is wrong with the catalog: in rare cases, a problem with the catalog 
data could erroneously show photos as missing. Verify, repair and/or update the 
catalog using the techniques explained in Chapter 11.

Locating missing photos
If a thumbnail shows a question mark (see Figure 
3–61), Lightroom can’t find the image file on disk 
and you cannot process it in Develop. If the file 
doesn’t show a preview, it’s because the previews 
were not built before the file went missing. In many 
cases, you will see a preview even though there’s 
also a question mark. Click the question mark on a 
thumbnail and then navigate through the file dialog 
boxes to find the image file on disk. Press Return or 
Enter to relink the photo.

Sometimes it takes a few moments for 
Lightroom to update the location for the re-
linked photos and remove the question marks. 
Try changing the view mode or zoom ratio.

If you no longer want the missing photo(s) in the catalog, remove them using the 
methods described earlier in this chapter. Just remember you’ll be deleting all the 
Lightroom metadata for these files as well.

Find Nearby Missing Photos
In the dialog box for locating 
missing photos, click the checkbox 
to Find Nearby Missing Photos 
(see Figure 3–62). Once you’ve 
successfully relinked a missing 
folder or file to the correct location 
on your hard disk, Lightroom will 
find and relink all the others, if possible.

Figure 3-62

Figure 3-61
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attention to what I was doing. So for now, I keep everything but the most obvious wasted 
pixels and I go back later to permanently delete photos that really deserve it.

As your image library grows to tens or hundreds of thousands of images, it may become 
necessary to delete unwanted images in order to save potentially significant amounts of disk 
space. Plan to come back to your library periodically in the future to re-confirm your editing 
decisions and delete unwanted files for good. You’ll have better perspective with the benefit 
of hindsight. For now, just use the Lightroom image sources, filters etc. to hide the images 
you don’t want to work on now.

Synchronize Folder
The Synchronize Folder command compares what’s in the catalog with the contents of 
the folder on disk and allows you to update the catalog accordingly. This is something you 
should get in the habit of doing every now and then.

Whenever you’ve made changes to the contents of a folder outside Lightroom, such as 
adding or removing images, renaming files, etc., you should synchronize the folder. For 
example, if you use Adobe Bridge, Adobe Camera Raw, Photoshop or Elements to edit 
photos, you’ll often need to synchronize them in Lightroom when you’re done, otherwise 
Lightroom won’t know what happened.

Right-click or Ctrl+click on the 
folder name, and then choose 
“Synchronize Folder…” from the 
contextual menu. A dialog box 
appears (see Figure 3–63) with 
the following options:

•	 Import new photos: if files 
are found in the folder on disk 
that are not in the catalog, the 
number of those files will be 
shown. If you want to have Lightroom import these new photos, check the box. They will be 
imported using the Add method; see Chapter 2 for more in this. If no new files are found, (0) 
will be shown and this section becomes dimmed and unavailable. 

•	 Show import dialog before importing: if new files are found, this option becomes 
available. Check this box to open the Import window prior to performing the sync. This 
will allow you to verify the images being added and check for any metadata that may be 
applied during the import. If you’re sure that no settings conflicts exist, go ahead and do 
the sync without checking the Import window.

Be careful skipping the Import window
This is extremely important: the Import window retains all the settings from 
your most recent import. If you sync a folder and skip opening the Import window, any 
metadata presets used for the previous import will also be applied to the files in this sync. 

KEEP EVERYTHING IN ONE MAIN FOLDER
For most photographers, the first step in organizing your image library is to get everything 
into one place. If you have disorganized files and folders in different locations, start by 
putting them all into one top-level folder. Call it “Photo Library” or “My Photos”; whatever 
you like. You can use your User\Pictures folder temporarily for this, but eventually, I 
strongly recommend moving your master photo library off your system disk. 
Keeping your image library on a separate disk from your system makes managing and 
backing up your photo library easier and, more importantly, allows you to make updates 
and changes to your operating system and applications without affecting your image 
library. After you have everything in one main folder, use subfolders to further subdivide 
the groups of files based on date, location, subject, client name, etc.

DEALING WITH DUPLICATE PHOTOS
Finding and deleting duplicate photos is one of the most challenging tasks for all 
photographers cleaning up their photo archives. If you’ve imported everything from your 
hard drives, you can use Lightroom’s text filters to search for files with duplicate names 
that may be contained in different folders. Sometimes, knowing which one is the current 
version can be the biggest challenge. You can use the information in the metadata panel 
to check revision dates, etc. to help you decide. When you’ve identified these unneeded 
duplicates, you can delete them using the methods described earlier in this chapter.

Although you can use filters and smart collections to sort and view photos using all 
kinds of criteria, in all honesty, using Lightroom isn’t always the easiest way to deal with 
duplicate photos. (Currently, there is no “Find Duplicate Files” command.) You may have 
more success with standalone system utilities designed just for this purpose; see the 
Appendix for links to some recommended software.

SOME THOUGHTS ABOUT DELETING PHOTOS
Many photographers permanently delete rejected images to conserve disk space and 
maybe also to preserve a little pride (none of us wants to look at our worst images). If you 
choose to do this, I recommend you give it some time before you do.

During editing in Lightroom it’s faster, easier and safer to simply hide unwanted photos 
from view rather than actually delete them. Deleting images in the heat of the moment 
introduces the risk of accidentally trashing something important. If you wait to do it at a 
later date, you’re less likely to make a mistake.

Plus, we can often learn more from our failures than from our successes. Trashing your 
worst shots right away can cramp your creative development and impede the learning 
process. Keep the bad photos for a while and take the time later to really understand what 
worked and what didn’t. Think about how you would do it differently next time. 

In my twenty-plus years of professional imaging work, managing huge volumes of digital 
files, there have been a couple of times when I accidentally deleted something that I 
shouldn’t have… and for which there was no backup. It always happened in the midst of 
the production workflow, when I was doing several things at once and not paying enough 

Figure 3-63
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catalog. Because I add photos to collections after the initial edits, using collections—instead 
of working in the original folders—reminds and assures me that my editing for those photo 
shoots was completed and I’m now seeing only the final selects.

Use collections more than folders
As you move through the workflow, I strongly recommend that you end up working much 
more from collections than you do folders. The flexibility offered by collections is one of the  
key advantages of using a database-driven system.

Collections panel
You create and manage 
collections with the 
Collections panel, near the 
bottom of the left panel 
set (see Figure 3–64). The 
Collections panel is persistent 
in all modules—unlike 
Folders, you can access 
your collections from 
anywhere in Lightroom 
(another advantage of using 
Collections over Folders).

There are three main types 
of collections: regular 
collections, smart collections 
and output module 
collections. You can group 
your collections together in 
collection sets.

Collections badge
When a photo is in a 
collection, Lightroom shows a 
collection badge on the Grid 
thumbnail (see Figure 3–65). 
Collections badges only show in folders and sources other 
than the specific collection itself, though if the photo is also 
a member of other collections, it will be displayed. Click the 
badge to go to the photo in that collection.

MAKE A COLLECTION AND ADD PHOTOS TO IT
Regular collections are those you create manually. These 
“dumb” collections aren’t based on any predefined criteria; 
you can create collections yourself for whatever purpose you 
choose, and add photos to them however you see fit.

This means that you could easily—and inadvertently—apply a metadata preset and/or 
Develop settings to the files being added. For this reason, I almost always show the Import 
dialog before importing and verify the settings before executing the sync.

•	 Remove missing photos from catalog: check this box if you want to get rid of any 
files with broken links. Do this with care, because in some cases you might want to re-
link them instead. Remember that when you remove items from the catalog, all their 
processing data goes, too. (You can preview the missing photos first; see below.)

•	 Scan for metadata updates: tick the box to enable the option for Lightroom to 
check that the metadata contained in the catalog is up-to-date with what’s contained 
in the file on the disk. (Metadata status is a very important topic, and you can learn 
a lot more about it later in this chapter.) I usually leave this unchecked because I 
manage my metadata status manually.

Once you’ve chosen the options you want to perform for this Synchronize Folder 
operation, you have several buttons to consider, across the bottom of the dialog box:

•	 Show Missing Photos: if Lightroom detects there are missing photos in the selected 
folder(s), you can click this button to see them in the main preview area. (Note that 
doing this will effectively end the current sync operation; you’d need to re-start it 
when you’re ready to actually sync the folder.)

•	 Cancel: closes the dialog box without performing the sync.

•	 Synchronize: if you have the option enabled to show the Import dialog before 
importing, clicking the Synchronize button will open the Import window. In this case, 
work through the Import window just as you normally would (and as covered in 
Chapter 2) and click the Import button to initiate the sync. If the Import dialog option 
is disabled, when you click this button Lightroom immediately begins the sync.

Sync top-level folders periodically
Syncing parent folders also syncs subfolders. Every so often, run a sync on your upper-level 
parent folders, just to make sure everything’s up to date in the catalog.

Collections: Organize things however you like
Like filters, collections are one of Lightroom’s great strengths. Think of collections like 
“virtual folders”: these groupings of images exist only within the Lightroom database. 
You can make collections for any purpose, subject or topic and you can use as many 
collections as you want. A single photo or virtual copy can belong to any number of 
collections, without requiring additional copies of the file on disk. Adding or removing a 
photo from one collection doesn’t necessarily affect it in others.

I’ve set up numerous collections to hold client work, portfolios, exhibition entries, 
magazine submissions, Web galleries, etc. I have collections for work-in-progress, and 
collections for uncategorized images waiting to be put in a more permanent place in the 

Figure 3-65

Collection sets

Regular collections
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Saved Books, 
Slideshows, Prints 
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Figure 3-64

⌘+N or Ctrl+N
New collection
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Go to Collection
Right-click or Ctrl+click on a photo; if the 
photo is in any collections (not smart 
collections), they will be listed in the 
popup menu under Go to Collection. 
Choose from one in the list to select the 
photo in that collection (see Figure 3–66).

SET AS TARGET COLLECTION
You can set any regular collection as 
the target collection. Right-click or 
Ctrl+click the name of the 
collection and choose 
Set as Target Collection 
from the contextual menu 
(see Figure 3–67). A white 
plus symbol next to the 
collection indicates it is 
targeted. Photos in the 
Target Collection show a 
gray dot on the top right 
corner of the thumbnail (see 
Figure 3–68). Clicking the 
dot or pressing the B key will 
add and remove photos to and from the target collection. To reset the targeting, uncheck the 
option from the menu and the Quick Collection will again become the target collection.

Duplicating collections
New in Lightroom 4: to copy one or more collections, hold Option or Alt while dragging 
in the Collections panel. If you drag to a different collection set (see below) the collection 
will be copied using the same name. If you drag to the same location Lightroom copies 
the collection and appends “Copy” to the end of the original name.

Quick Collection
The Quick Collection is a built-in collection 
that is best used as a temporary holding 
place during editing or organizing. It’s a 
useful tool for combining search results 
and filtered views. For example, during 
editing, you could add photos to the 
Quick Collection as an intermediate step 
to getting them all into one permanent 
collection later. There is only one Quick 
Collection available in each catalog. Access 
the Quick Collection in the Catalog panel (see Figure 3–68). Photos in the Quick Collection 
(when it’s the Target Collection) show a gray dot on the top right of the thumbnail image (see 
Figure 3–68). To remove a photo from the Quick Collection, click the dot, or press B.

Click the + button on the Collections panel header (see Figure 3–64) and choose Create 
Collection. Type a name for the collection and configure the other options to your 
liking. For example, if you have images selected, you can automatically add them to the 
new collection. Press Return or Enter to create the collection.

To add photos to a collection later, drag their image thumbnails onto the collection 
name in the panel, or use the Target Collection option discussed below.

Can’t add to a collection?
If you try to add a photo to a collection and you’re not able to, it’s because the photo is 
already in that collection. If it’s not visible within the collection view, check the filter status.

Drag and drop a folder to make a new collection 
New in Lightroom 4: you can drag a folder from the Folders panel onto the Collections 
panel to create a new collection using all the contents of that folder.

Multiple instances of a single photo on disk
When you put a photo into a collection, Lightroom creates a new instance of the photo 
in the database. It’s still referencing the original file on disk, and by default, the settings 
for the new instance are linked to the settings of the original—changing one will 
change the other. For example, if you add a photo to a collection and then convert it to 
black and white from within the collection, the original file in the folder source will also 
show those changes, and vice versa.

However, when adding photos to a collection it is also possible to create a new virtual 
copy of the file in that collection. A virtual copy is a special instance made from the 
original. When you make a virtual copy, though it is still referencing the original file 
on disk, its link to the original settings in the catalog is effectively severed. Changing 
settings on a virtual copy does not affect the original, or vice versa. Virtual copies are 
discussed further in Chapter 4.

When creating a collection from selected photos or adding photos to an existing 
collection you have the option to make a new virtual copy. I usually leave this option 
unchecked because I want the photo to be the same in all the sources from which I 
might access it.

REMOVING PHOTOS FROM A COLLECTION
To take one or more photos out of a collection, select the photo from within the 
collection and press Delete. This will immediately remove a file from a collection 
without presenting a confirmation dialog box. (This is undo-able; just be sure to undo 
the removal before going on to other work.) Deleting a photo from a collection doesn’t 
affect instances of that photo in other collections, or the original file on disk.

MOVING AND COPYING PHOTOS BETWEEN COLLECTIONS
You can add a photo to as many collections as you would like. However, there’s no 
straightforward way to move a photo from one collection to another. You need to
add the photo to the new collection and then remove it from the first.

Figure 3-66

Figure 3-67

Figure 3-68
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•	 You can modify the rules used for a smart collection by selecting Edit Smart Collection 
from the popup menu.

Import and Export Smart Collections
You can transfer your smart collections between catalogs. Right-click or Ctrl+click on the 
smart collection name and from the contextual menu choose Import Smart Collection 
Settings or Export Smart Collection Settings.

Output Module Collections
New in Lightroom 4: Lightroom 4 introduces a special kind of collection. Each of the 
output modules—Book, Slideshow, Print and Web—can save these special collections (see 
Figure 3–64). Although they appear in the Collections panel and can be managed along with 
other types of collections, it’s important to understand that the creations saved from these 
modules contain much more data than the image references alone. For example, a saved 
Book has all the settings used for the creation of the Book, in addition to the instances of the 
actual photos referenced by the Book. In the Library module, these look and feel like regular 
collections. 

From the Collections panel in Library (and Develop), you can double-click on a saved Book, 
Slideshow, Print layout or Web Gallery or click the arrow to the right of the collection name. 
This will take you to the corresponding module and load that creation using the included 
photos. (From within the output modules, a single click does the same thing.) The chapters 
discussing each of the output modules explain how to save those items and manage them 
in the Collections panel.

With these changes, output module data is no longer stored in regular collections. Also 
important to note is that output module collections can now be made as children of regular 
collections when they’re being saved, or later using drag and drop.

Collection Sets
Like a folder can contain subfolders, a collection set can contain collections and other 
collection sets. A collection set is designated in the Collections panel list by a special icon 
(see Figure 3–64). Collection sets are a great way to keep your collections organized into 
larger categories. To make a new collection set, click the + button on the collections panel 
header and select Create Collection Set. To rename a collection set, right-click or Ctrl+click 
on its name and select Rename from the popup menu.

Managing the Collections panel
Items in the Collections panel can be sorted by category (“kind”), and then alphabetically 
by name. By default, collection sets will always show in a group at the top of the list, with 
individual collections listed below. You can change the way the collections are sorted: click 
the + button and choose an option from the popup menu (see Figure 3–64). Within a set, 
the collections and sub-sets are always sorted alphabetically.

To add or remove photos from the Quick Collection, press the B key if it’s the target 
collection (see above), or hover your cursor over a thumbnail and click the gray circle in the 
top right corner.

Smart Collections
Smart collections are automatically populated with photos that match provided criteria. You 
can set up smart collections to show photos from anywhere in the catalog. As you work with 
photos and their settings are changed, Lightroom will dynamically add or remove them from 
the smart collections.

You could make smart collections for photos made in the last 30 days, photos that need 
keywords, photos to prepare for a client, photos to be sent to a lab for printing, etc. All these 
smart collections would be based on file metadata, but you can use other criteria as well.

New in Lightroom 4: the available criteria for smart collections has been significantly upgraded, 
and now includes Metadata Status (saved/unsaved, etc.), dng file type information and Has Fast 
Load Data, Is Proof (for soft proofing in Develop), gps and map data/saved locations.

MAKE A 
NEW SMART 
COLLECTION
On the Collections 
panel, click the + 
button and choose 
Create Smart 
Collection (see 
Figure 3–64). In the 
dialog box, type 
a name for the 
collection, and then add the desired criteria. By default, a new smart collection just contains 
one rule. Use the plus or minus buttons to add or remove additional rules (see Figure 3–69). 
When you’re done, press Return or Enter to create the smart collection.

More options for rules
Hold option or Alt when creating rules; this provides additional, “advanced” options.

A few notes about smart collections:

•	 Since smart collections work automatically from photo metadata in the catalog, you 
can’t directly add or remove images from smart collections by dragging and dropping 
them.

•	 Smart collections cannot use custom (user) sort orders.

Figure 3-69
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Disappearing thumbnails
During an edit, if you change any of the attributes 
of a photo and it disappears from view, it’s because 
filters are enabled. Change or disable the filter set 
(discussed in the next section).

FLAGS
Pick flags and their opposites, reject flags, may be 
the simplest form of editing decision—yes or no. 
You can apply a pick flag by clicking the flag icon 
in the top left of the photo’s thumbnail (see Figure 
3–71) or you can use the keyboard shortcuts.

New in Lightroom 4: flags are global. (They used 
to be specific to the source in which they were 
applied.) Now, if you apply a pick flag to a photo 
in a folder, and then put that photo in a collection, 
the photo will still be flagged in the collection, too.

Flag status is not written to xmp metadata
Pick flags are specific only to the current catalog. When you save xmp metadata to disk, 
pick flag status is not recorded. If you apply flags in one catalog, save out the metadata 
and then import those into another catalog, the pick flag status will be reset. For this 
reason, I prefer to use stars for most of my editing because those ratings are saved out to 
the files and can also be read by other software.

Marking Rejected Photos
Using the reject flag helps hide unwanted photos and speeds their removal from your 
catalog. When they’re unselected, thumbnails for rejected photos are dimmed in the 
Grid View (see Figure 3–72 next page).

Delete Rejected Photos
After marking photos as rejected, press ⌘+Delete or Ctrl+Backspace to filter the rejected 
photos. A dialog box appears allowing you to remove the photos from the catalog or 
delete them from disk.

Refine Photos
If you use flags, Refine Photos helps facilitate automated mass-deletion of photos from 
your Library. When you run Refine Photos, images that had Pick Flags will be set to 
Unflagged, and previously Unflagged photos will get a Rejected flag. Usually, you’d use 
this in conjunction with Delete Rejected Photos.

RATINGS
Star ratings (see Figure 3–73) are a very common method of ranking photos and other 
digital media. They are primarily meant to be used as a heuristic ranking model, e.g. five 
stars is better than one. By default, photos come into the database with no stars, unless 
they had stars applied in another program.

Use leading numerals
To force collections or sets to different positions in the list, I often use numeric characters 
in front of the main part of the name (see Figure 3–64).

MODIFYING COLLECTIONS 
IN THE LIST
To delete a collection or set, select it 
in the list, then either click the minus 
button on the panel header (which only 
appears when an item is selected in 
the list; see Figure 3–70) or right-click/
Ctrl+click the collection name and select 
Delete from the popup menu. Deleting 
a collection will not affect any original 
photos in disk, or instances of photos 
that might also be in other collections. Deleting a collection set 
will also delete all the collections—and other sets—contained within it.

Introduction to Publish Services
Lightroom has the ability to “publish” photos to hard drives and Web sites directly from 
the Library module. This provides great capability for integrating Lightroom with outside 
services such as social media and photo-sharing Web sites in addition to networked 
folders used by workgroups. With Web sites that support user comments and feedback 
(e.g. the Facebook “Like” button), Lightroom can automatically sync those comments into 
your catalog; that’s what the Comments panel on the right is for. Since publish services 
are a sophisticated form of export, you can learn about them in Chapter 5.

Smart collections connection with publish services
Publish services are similar to smart collections in many ways. In fact, you can import 
smart collection settings into publish services. Using this method allows you to 
dynamically generate collections of photos and videos that can be easily synchronized 
with Web sites and shared folders.

Attributes: Tag photos with identifying marks
When you assign attributes to photos you can quickly and easily find and sort them in 
many ways. Lightroom’s attributes are Star ratings, Color labels and Flags. With just these 
three sets of attributes you can differentiate between your photos in many ways.

There are several ways to apply or remove attributes on photos. Attribute controls are 
available on the Toolbar, but they are not all visible by default. Click the triangle button at 
the right side of the Toolbar to enable or disable items in the Toolbar (see Figure 3–29).

Use a consistent meaning
Whatever labeling system you prefer, do your best to use a consistent system of 
identifying your photos. For example, all images with one star ideally should have the 
same significance in your catalog, such as indicating a first round select.

Figure 3-71

Figure 3-70
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Pondering the meaning of stars
A rating system is most effective when the attributes always have the same meaning, 
regardless of context. For example, multiple photos with two stars should always have 
the same significance regardless of the folder, collection or other sources they might be 
contained in. This is more difficult than it sounds.

Consider that when you’re editing a batch of photos, the ratings necessary to complete 
that round of editing may differ from one shoot to the next. With some shoots, you 
might only need to use one or two stars to identify the keepers. Other times, you may 
need more stars to further refine the selects from rejects. This is one of the challenges of 
using a heuristic model in varying sources.

COLOR LABELS
You can apply a color label to a photo to 
indicate a specific meaning (see Figure 
3–74). In Lightroom, color labels correspond 
with accompanying text values. The defaults 
are Red, Yellow, Green, Blue and Purple. You 
can apply standard color labels by clicking 
the color label swatch on the Toolbar or 
expanded thumbnails, by typing text into 
the Metadata panel, or with the shortcuts. 
Color labels are global.

The key to using labels effectively is using 
them consistently in the same way. For 
example, a photographer might apply a green 
label to mark portfolio images. Or you could 
label a set of images blue to indicate they are 
to be stitched into a panorama, or label photos purple to indicate they had been reviewed 
by a client, etc. I don’t often use color labels; if I need to differentiate between photos with 
the same rating, I usually use keywords or titles and captions. However, I’ve known many 
photographers for whom using color labels is an essential part of a highly-evolved workflow. 
This is one example of how workflows can be personalized based on your own preferences.

Color label sets
You can make multiple Color 
Label Sets that have different 
definitions for the colors. Choose 
Metadata➔Color Label Set to 
edit the current set or make new 
ones (see Figure 3–75). If you have 
used Adobe Bridge to apply color 
labels, be aware that the names 
of the default color labels differ in 
Lightroom and Bridge. (Lightroom offers a built-in color 
label set thatmatches that of Bridge but it’s not the default.)

Like many photographers, I begin rating with one star, going up to two, three, etc. to a 
maximum of 5. But some people start at 3 and go up or down from there. You can use 
whatever system you choose, but it’s practical to use an ascending order of ratings. In all 
cases, using a standard system can speed up your workflow and ease decision-making.

Apply a star rating to one or more 
selected photos by clicking the 
stars in the Toolbar or the expanded 
thumbnails (see Figure 3–73), or by 
using the shortcuts. Clicking on the 
current rating or pressing 0 resets the 
photo to “unrated”.

Star ratings are global throughout 
Lightroom; that is, if you apply stars 
in a folder source and then add those 
photos to a collection, the rating will 
be retained.

Figure 3-74

Figure 3-73

Figure 3-72

Figure 3-75
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Filters can be used to search your catalog for specific images using any criteria. After you’ve 
created a filtered view, you can save a filter preset and/or add those photos to a new collection 
for quick access later. Typically, you will start by previewing photos in any image source, such 
as All Photographs, or a folder or collection, and then apply filters to see only the photographs 
you want from within that source. In this way, filters are used to refine the other sources.

Filter by location
New in Lightroom 4: when photos have gps data available, you can use a Metadata filter to 
find them by location. (You can use the new Map module to add location data to photos.)

Filter lock
By default, filters are specific to the folder or collection source to which they are applied, and 
are saved automatically, so different sources can have different filters enabled. However, filter 
settings can be “locked” so the filter’s criteria persist even when switching between sources. 
Click the lock icon on the Filter Bar to lock the filter in place (see Figure 3–78).

FILTERS ON FILMSTRIP
At the right side of the Filmstrip is a set of filter controls (see Figure 3–77). If they’re not visible, 
click the word Filter: to expand/contract the filters section. These controls are persistent in all 
the modules and all view modes, so they’re the easiest to access. They provide essentially the 
same functionality as the filter bar (see below), and you can select saved filter presets, but you 
can’t configure complex metadata filters here.

The filter switch
The filters section on the Filmstrip includes a switch that disables or enables the current filter 
(see Figure 3–77). This can produce a result similar to clicking None on the Filter Bar (see 
below), but will only turn off filters based on Attributes. To turn everything off, use None on the 
Filter Bar, or the shortcut.

Don’t modify filters just to disable them
If you want to temporarily show photos that don’t match the current filter set, you don’t need to 
modify the filters, just turn them off. For example, if you have a filter enabled to only show picks and 
need to see the un-flagged photos also, don’t remove the pick flag from the filter; turn the filter off 
using None or the Filmstrip switch. This allows you to keep filter sets intact for later use.

FILTER BAR (GRID VIEW ONLY)
The Filter Bar is available in Grid view mode (see Figure 3–78). If it’s not visible, make sure you’re 
in Grid view and use the shortcut or the option under the View menu to show the Filter Bar. 
Using the Filter Bar, you can set up your own filters based on an unlimited range of criteria, 

Custom label names
On the Metadata panel, you can type any 
text into the Label field (see Figure 3–76), but 
the five standard colors listed above are the 
only ones that will actually show a color on 
the thumbnail. The Label field itself is simply 
editable text (whereas flags and stars are 
invariable) so you can enter anything you 
want for the label definition. If the text does 
not match a label in the current color set, the 
color used for the thumbnail will be white. 
(Note: custom is an available option in the 
attribute filters; see next section).

Custom color labels reset in Lightroom 4
It’s been reported that some color labels and 
color label sets using custom names may 
get reset to the defaults in Lightroom 4.0. If 
you’ve upgraded a catalog from an earlier 
version, be sure to check your custom labels!

AUTO ADVANCE
With Auto Advance enabled, as you apply any attributes to images in Library (flags, 
stars, etc.) Lightroom automatically selects the next image in the current source. Select 
Photo➔Auto Advance to toggle the control on and off.

Filters: Show photos and videos based on criteria
This is one of the most powerful and important features for organizing and sorting your 
photos in Lightroom: applying filters determines which photos will be shown in the 
preview area and Filmstrip.

Filters are configured from the top, right section of the Filmstrip (see Figure 3–77) and 
with the Filter Bar at the top of the main preview area (see Figure 3–78). Lightroom comes 
with some built in filter sets, including Flagged, Rated, etc. Load filter sets using the popup 
menu on either the Filter Bar or the Filmstrip.

Figure 3-78

Figure 3-77

Figure 3-76
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Step 3. Use the menus to set up your search criteria (see Figure 3–80). The first menu default 
is “Any searchable field”, which will look for the text string anywhere in the files. To narrow the 
criteria, open the menu and choose from the other options, which include Filename, Title, 
Keywords, etc.

Step 4. Next, set how the filter will search using the text (see Figure 3–81). The options are 
Contains, Contains All, Contains Words, Doesn’t Contain, Starts With, and Ends With.

Step 5. Finally, type in the text to search for (see Figure 3–82). As you type, Lightroom 
dynamically updates the filtered view to show only the files matching the criteria you’ve 
selected.

To start over and reset the text search to show all the unfiltered photos in the source, click the 
X at the right of the text search field (see Figure 3–82).

Special text search characters
Add ! (exclamation mark) in front of a word to exclude it from the search results. + before a 
word activates the “Starts With” criteria for that word. + at the end of a word activates the “Ends 
With” criteria for that word.

If you’re searching on file names and they contain hyphens or underscores, you don’t need to 
include them in the text search field; Lightroom will find the whole words with or without the 
separating punctuation.

Tooltips
Remember that when you hover with your cursor over an item for a few seconds, for most 
objects in the interface, a tooltip appears. This is a great way to learn and memorize what the 
buttons do.

including image file properties and metadata such as keywords and attributes. Filters can 
be combined to create any kind of file selections and can be saved as presets for later use.

Showing the whole Filter Bar
If the Lightroom application window and main preview area are not wide enough, the 
right side of the Filter Bar will not be visible (see Figure 3–79). Make the window larger and 
the panels narrower, or hide unused panels, to see the entire Filter Bar.

Example Filter workflows
Following are several examples of creating filters. You can work through these steps to 
get an idea of what’s possible with filters, but of course, this is only scratching the surface. 
The main point to understand is that any time you want to isolate some photos from 
anywhere in the catalog—even from all the photos in the catalog— filters are the best 
way to do it.

Apply a Text filter
The Text filter is essentially a text search engine. It’s most useful for searching for keywords, file 
names, and any other text that may be associated with image files or virtual copies. The text 
filter can find a string of text contained—or not contained—anywhere in the file data.

Step 1. Start by selecting the main image source you’ll be filtering. If you want to search 
the entire catalog, use the All Photographs catalog source, as I did for this example. 
Otherwise, choose a folder or collection to start with.

Step 2. Then, with the Filter Bar visible, click on the Text filter (see Figure 3–80).
The text filter options become visible below.

Figure 3-79

Figure 3-80

Figure 3-81

Figure 3-82

⌘+F or Ctrl+F
Text filter
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Apply a Metadata filter
You can create image filters based on any file metadata, including exif information such 
as exposure setting, lens used, capture date, flash on or off, etc. (see Figure 3–84). You can 
click and drag the bottom edge of the metadata filter section to expand and compress 
the filter bar. If the contents of the columns 
are too long to show their entire contents, 
use the scroll bars at the right of each 
column to scroll up and down.

Step 1. Start by selecting the main image 
source you’re filtering.

Step 2. Click the Metadata button in the 
Filter Bar. The default Metadata filter loads, 
with four sets of criteria: Date, Camera, Lens 
and Label (see Figure 3–84). You can use 
add, remove and change these columns 
however you like.

Step 3 (Optional). To add or remove 
columns from the metadata filter, place 
your cursor over the column header and a 
small icon appears at the right (see Figure 
3–85). Click here and use the menu to add or 
remove the column.

Step 4. To change the metadata being used 
in a filter column, click the column header 
to select a type from the popup menu (see 
Figure 3–86).

Apply an Attribute filter
This is the core set of filters used for the Lightroom editing sequence outlined at the 
beginning of this chapter: ratings, flags and labels. With the Attribute filter you can also 
filter by Kind: Master Photos, Virtual Copies and Videos. (This is often faster than using a 
Metadata filter, which is covered next.)

Step 1. As before, start by selecting the main image source you’ll be filtering: if you want 
to filter the entire catalog, use the All Photographs catalog source. Otherwise, choose a 
folder or collection to start with.

Step 2. In the Filter Bar, click Attribute to enable the filter (see Figure 3–83).

Step 3. Click the buttons in the Filter Bar to set what attributes will be used for the filter 
(see Figure 3–83). The main options are Flag, Rating, Color and Kind.

Flag: filter based on flag status—unflagged, picks, or rejects. You can click multiple flags to 
refine the criteria; click a flag again to remove it from the filter criteria.

Rating: filter based on the number of stars applied. Between the word Rating and the first 
star is a menu option to choose Rating is greater than or equal to, Rating is less than or 
equal to, or Rating is equal to. Click a star to set the desired rating level for the filter.

Color: filter based on a color label, unlabeled, or a custom label. Click multiple colors to 
create an aggregate filter of labels. Click a label to remove it from the filter.

Kind: filter based on “Master” (an actual file on disk), virtual copies, or videos. Click to add 
multiple kinds to the filter, if you like.

Figure 3-83

Figure 3-84

Figure 3-85

Figure 3-86
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FILTER PRESETS
To save a filter preset, get the filter set up the way you want, then click the menu at the 
right side of either the top Filter Bar or the filters section on the Filmstrip (see Figure 
3–88). From the menu, select Save Current Settings as New Preset. Give your preset a 
meaningful name; it will then be listed in the filters menu. You can access your saved 
filter presets from both the Filmstrip and Filter Bar.

Quick Develop
The Quick Develop panel in the Library 
module contains a limited subset of the 
image adjustment controls available in 
the Develop module (see Figure 3–89). 
(It’s a good idea to learn a bit about 
Develop adjustments before doing a 
whole lot in this panel.) Click the black 
triangles to expand all the sections on 
the Quick Develop panel (see Figure 
3–89).

One of the main advantages of Quick 
Develop is you can apply adjustments 
to multiple photos at once. Because of 
the relative nature of Quick Develop, 
each photo can be processed 
differently, depending on their previous 
settings. To apply Quick Develop 
settings to multiple photos, select 
them in Grid view. (If you’re previewing 
a single photo in Loupe view, Quick 
Develop adjustments will be applied to 
only that image).

With one or more photos selected, click 
the buttons in the Quick Develop panel 
to adjust the settings. Right-facing 
arrows increase the value for each 
setting; left arrows decrease that value. 
Single arrows increase or decrease by 
small values; double arrows increase the adjustments in larger increments (see Figure 
3–89). Hold your cursor over each setting to see its tool tip.

Develop adjustments are described in much more detail in Chapter 4.

Press Option or Alt
This toggles Clarity/Sharpening and Vibrance/Saturation on the Quick Develop panel.

Step 5. From within each column, continue to select the metadata values to use for the 
filter. As you select criteria, the values in the other columns change to reflect the filtered 
results.

Selecting multiple values
You can select multiple criteria within the metadata columns. Hold Shift to select a 
contiguous range of options. Control or Ctrl selects individual, non-contiguous criteria (see 
Figure 3–87).

Reset filters to None
Clicking None on the Filter Bar (to the right of the main filter type selectors) deactivates 
the current filter set. The previous filter settings remain intact; just disabled.

COMBINING MULTIPLE FILTER TYPES
You can click multiple filter names to add controls for multiple filter types at the same 
time. For example, you could use a Text filter with Attributes added, or Text with Metadata, 
etc. A highlighted label indicates that filter is active (see Figure 3–88). Click the name of 
the filter to enable or disable it in the current filter set. (If you spend time configuring a 
complex filter set, you should consider saving a preset to use again later.)

Figure 3-87

Figure 3-88

Figure 3-89
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worry too much about Process Version at 
this point. But if, on the other hand, you have 
worked on pictures in Lightroom 3 or earlier, 
and you now want to use the new Quick 
Develop tools, there are a few things you need 
to understand.

The available settings are different depending on 
the process version. Photos newly imported to 
Lightroom 4 will use PV2012 and will show the 
new controls in Quick Develop (see Figure 3–89). 
Those developed with earlier process versions 
will still show the old controls (see Figure 3–90). 
This means you could end up using one set of 
Quick Develop controls for photos with PV2012 
and another for older versions.

More importantly, the adjustments used by 
the older process versions (2003 and 2010) do 
not map directly to the new controls. If you 
convert photos using older process versions 
to PV2012, odd shifts will likely occur, requiring 
you to reprocess those photos one by one. 
Unless you want to reprocess your photos, I 
wouldn’t recommend you convert them to the 
new process version.

Process Version is covered in much more 
detail in Chapter 4.

SYNC SETTINGS
You can synchronize 
Develop settings between 
multiple photos. When 
you use Sync Settings, the 
settings from the target 
photo are applied to the 
other selected photos. 
First, select the photo 
from which you want to 
copy the settings, and 
then select the other 
photos to have the new 
settings synced to. Click 
the Sync Settings button 
(see Figure 3–91). A dialog 

The Preset menu on the Quick Develop Panel
You can apply saved Develop presets to photos using the Quick Develop Panel. To remove 
all Develop adjustments from the selected photo(s), choose General – Zeroed from the 
menu. Note that, in contrast to the Quick Develop controls, when you apply a Develop 
preset, the applied values are still absolute. We don’t (yet) have relative presets.

New in Lightroom 4: the Quick Develop presets menu is organized in a hierarchical 
folder structure.

Crop presets in Quick Develop
Using the Crop Ratio menu in Quick Develop, you can quickly and easily apply crop 
presets to multiple photos in Library. (To use custom crop presets you’ll need to create 
them first; see Chapter 4 for more on this.)

RESET ALL
This button on the Quick Develop panel (see Figure 3–89) resets the selected photo(s) 
to the Adobe Default settings. This applies to all photos selected when in Grid view, or a 
single photo when in Loupe view. All other metadata (keywords, copyright, title/caption, 
etc.) are not modified.

UNDERSTANDING ABSOLUTE AND RELATIVE ADJUSTMENTS
Lightroom provides two places for you to apply adjustments directly to photos—Library 
and Develop—but in each module, the changes are applied differently. Using the Quick 
Develop panel is very different from using the full Develop module. Though the names of 
the adjustments are the same, and those adjustments produce the same visual changes in 
the individual photo(s), how the adjustments are applied makes all the difference.

In Library’s Quick Develop panel, all the adjustments are relative: the changes you make 
are applied on top of any existing adjustments. For example, if you start with a 
Saturation setting of +6 and click a single-arrow button to apply a +5 Saturation increase, 
the resulting value will be +11. The effects are cumulative. So if you have two photos with 
different Saturation values, let’s say +6 for one and +10 for the other, and you apply a 
Quick Develop Saturation increase of +5 to both of them, you’ll end up with values of +11 
and +15, respectively.

Conversely, when you set an adjustment in the Develop module, the slider value—or the 
number you type—is absolute. That means that the numeric value applies precisely that 
amount of adjustment, even when dragging the sliders. In the Develop module, if you 
repeatedly change an adjustment for a photo, the effects of two sequential adjustments are 
not cumulative. These adjustments are absolute and the numeric value shows exactly what it 
is. If you start with a Saturation value of +6 and change it to +11, it’s really +11, not +17.

INTRODUCTION TO PROCESS VERSION 2012
New in Lightroom 4: the settings available in Lightroom’s 4 Quick Develop panel have 
changed to reflect the new Process Version 2012 (PV2012). If you’re just starting with 
Lightroom and haven’t imported any pictures from earlier versions, you don’t need to 

Figure 3-90

Figure 3-91

⌘+Shift+S or 
Ctrl+Shift+S
Sync settings
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Lightroom catalogs—you can use keywords to find and organize photos in your archives, 
even if those keywords are never shown to the public.

Overview of the keywording workflow
You can apply keywords in the Import window, and then enhance them in Library, where 
you work with the Keywording and Keyword List panels. Start adding keywords near the 
beginning of the workflow, and continue adding and refining your keywords for selects as 
you move them through the pipeline.

When you apply keywords to photos they are stored in the current catalog. You can 
import and export keyword lists. You should budget time for managing your keyword list 
independently from your other photo editing work. 

Apply keywords to as many photos as possible at one time
As you go through your editing workflow, apply keywords in progressively finer detail. 
Start with the most generic terms that apply to the most photos, and gradually add more 
specific keywords to smaller groups and individual photos.

Keyword formatting
Within a photo’s metadata, keywords are separated by commas, and optionally, spaces as 
well (which I prefer). You can use single or multiple words. I recommend using specific, 
distinct phrases as keywords. For example, if I shoot in Rocky Mountain National Park, I will 
use the phrase “Rocky Mountain National 
Park” as a keyword, because it’s a name, 
and not “Rocky, Mountain, National, Park”. 
However, depending on the photo, I might 
also include the word “Mountains” as a 
separate keyword.

In the sections that follow, you’ll read about 
using the Keywording and Keyword list 
panels, working with keyword hierarchies, 
finding photos using keywords and my 
thoughts on general keywording strategies.

The Keywording panel
The Keywording panel shows the keywords 
applied to the selected photo(s) (see Figure 
3–94). You can edit Keyword Tags in the text 
field and/or click to apply keywords from the 
Keyword Suggestions and Keyword Sets.

Click the small black disclosure 
triangles to expand all the sections of 
the Keywording panel (see Figure 3–94).

box opens, allowing 
you to choose 
what settings 
will be synced 
(see Figure 3–92). 
These are Develop 
adjustments only—
not keywords or any 
other metadata. (To 
sync metadata, use 
the Sync Metadata 
button instead.)

COPY/PASTE SETTINGS
You can copy Develop adjustments from one photo and paste them to other photos. 
Copy/Paste is similar to Sync Settings. However, there’s one major difference: when 
you copy settings, they are stored in memory, and can be pasted to other photos later. 
Conversely, Sync Settings happens just the once; these synced settings are not saved 
anywhere. Otherwise, the Copy Settings dialog box is identical to Sync Settings in 
appearance and function.

To copy/paste settings, first select an image, then use the Settings➔Copy Settings 
command or shortcut. This opens the Copy Settings dialog box. Choose what Develop 
settings to copy from the selected photo. Then select one or more photos that will receive 
the pasted settings. Pressing the Paste shortcut (or using the Settings➔Paste Settings 
menu command) applies the copied settings to all the selected photos. All settings that 
are different will be pasted.

Keywords: Tag your 
photos for search
Keywords (also often called “tags”) are words 
and short phrases used to describe the content, 
theme and subject of a photo. In addition to 
literal descriptions, keywords can be used to 
describe metaphors, abstract concepts and 
graphical elements of the composition. If a photo 
has keywords applied, a badge shows on the 
thumbnail (see Figure 3–93). (Clicking a Grid 
thumbnail badge opens the Keywording panel.)

Why use keywords?
For most photographers, keywords are essential 
metadata that should be applied to every photo, 
especially those that will be posted online. Search 
engines read keywords embedded in image files and display search results based on 
the contents of this metadata. Keywords also have many potential uses within your local Figure 3-94

Figure 3-92

Figure 3-93

⌘+Shift+C or 
Ctrl+Shift+C
Copy settings

⌘+Shift+V or 
Ctrl+Shift+V
Paste settings
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KEYWORD SUGGESTIONS
As you keyword photos, Lightroom keeps track of other images to which you’ve applied 
similar keywords and, based on capture times, provides Keyword Suggestions (see 
Figure 3–94). There are up to nine keyword suggestions available at any given time; all 
the suggested keywords must already exist in the current catalog. The suggestions are 
constantly updated so, usually, when you apply a new keyword, the suggestions may 
change. Click a suggested keyword to apply it to the selected photo(s).

KEYWORD SET
Keyword Sets are designed to speed up your work when adding keywords to photos with 
similar subjects or themes (see Figure 3–94). You can make Keyword Sets using any criteria 
you like. Each Keyword Set contains up to nine words. Lightroom comes with several built-
in keyword sets: Outdoor Photography, Portrait Photography and Wedding Photography. 
There is also a selection for Recent Keywords.

Select a set from the popup menu to load that set of keywords. The keywords contained in 
that set are then shown in the panel. Click the keywords to add them to selected photo(s) or 
use the keyboard shortcuts 
for Set Keyword (see below). 
A keyword will be highlighted 
if it’s already applied to the 
photo; click the keyword again 
to remove it from the photo.

You can modify these sets 
and create your own sets. To 
edit a keyword set, open the 
popup menu and select Edit 
Set… The resulting dialog box (see Figure 3–95) lets you add, change or remove keywords 
from that set. You can enter any keywords you like in this box; if they don’t already exist 
in the catalog, they will be added to the Keyword List the next time they are used. If you 
make changes to a keyword set, the set will be listed as (edited). Open the menu again 
and select Update Preset or Save Current Settings to New Preset to save the changes.

SET KEYWORD
This is very different than Keyword Sets; it’s 
a shortcut. The nine most Recent Keywords, 
or those from the current Keyword Set, 
can be applied to selected photos using 
keyboard shortcuts and the Painter (covered 
later in this chapter), or with the Photo➔Set 
Keyword menu command. If you’re 
keywording photos and consistently using 
the same keywords, Set Keyword can save 
lots of time. Press Option or Alt to show the numeric keyboard 
shortcuts in the Keyword Set section of the panel (see Figure 3–96).

KEYWORD TAGS
With one or more photos selected, type your keywords into this text box to apply them to 
the selected photo(s) (see Figure 3–94). The popup menu at the top of the panel allows 
you to choose how keywords are shown in this section of the panel:

•	 Enter Keywords: in this mode, all the keywords applied to a photo are shown in the 
large text box in the top portion of the Keywording panel. This is the only mode 
that allows you to edit keywords in this panel. Click in the text box to add, 
change or delete keywords from the selected photo(s). Lightroom’s Auto Complete 
feature helps finish words for you as you type (this behavior is controlled by the 
option in Catalog Settings➔Metadata). Press Return or Enter when you’re done 
working in the text field.

•	 When multiple photos are selected, keywords showing an asterisk (*) are only 
applied to some of the selected images. In other words, if a keyword does not have 
an asterisk, it is applied to all the selected photos. To quickly apply a keyword to all 
the selected photos, simply delete the asterisk. (However, adding an asterisk doesn’t 
work the same way; to remove selected keywords from some photos use the other 
methods described below.)

•	 Keywords and Containing Keywords: this mode displays the keywords applied to 
the selected photo(s) along with their hierarchies, which is discussed below.

•	 Will Export: this mode displays the keywords that will be applied to the photos 
when you export them or generate creations in the output modules. Depending on 
how you’ve set up your keyword list, some keywords may not export. This is covered 
in the next section.

Add Keywords
If you only want to add keywords to selected photos—not change or remove them—
use the Add Keywords field. In the Keywording panel, where it says “Click Here to Add 
Keywords” (see Figure 3–94), type the new keywords to be added. When you’re done 
typing, press Return or Enter to apply the keywords to the selected photos.

Return/Enter or Esc
Always press Return or Enter when you’re done typing text into any field in Lightroom. Or, 
press Esc to leave that text entry field without committing the changes. If you don’t do 
this, and you use keyboard shortcuts, it’s quite likely that you will inadvertently type text 
into a field when you didn’t mean to.

Keyword Entry Preferences
In Lightroom Preferences➔Interface there are options controlling the behavior of 
keywording as you type: you can choose a different keyword separator (I recommend 
commas) and turn Auto-complete on and off.

Figure 3-95

Figure 3-96

⌘+K or Ctrl+K
Go to Add 
Keywords field

⌘+Shift+K or 
Ctrl+Shift+K
Go to Enter 
Keywords field

Option+0 or 
Alt+0
Next keyword set

Option+Shift+0 
or Alt+Shift+0
Previous 
keyword set
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USING THE KEYWORD LIST TO 
APPLY AND REMOVE KEYWORDS
With one or more photos selected, you 
can add or remove keywords to or from a 
photo by clicking the check box to the left 
of the keyword. You can also add keywords 
by dragging and dropping them from 
the list onto the photo, or vice versa. To 
remove a keyword from a photo, you can 
uncheck it from the list or use the controls 
in the Keywording panel. You can also add 
and remove keywords by right-clicking or 
Ctrl+clicking on the keyword, and then 
selecting the appropriate command from the 
popup contextual menu (see Figure 3–99).

The Target Keyword
You can select the popup menu option to “Use this as keyword shortcut” which allows you 
to apply that target keyword using the keyboard shortcut. When this option is enabled, a 
+ symbol shows next to the target keyword in the list (see Figure 3–97).

CREATING KEYWORDS 
IN THE LIST
Create new keywords in the list by 
clicking the + button at the top of the 
Keyword List panel. This opens the 
Create Keyword dialog box (see Figure 
3–100). In the Keyword Tag field, enter 
the name for the keyword. Explanations 
of the other options are below.

In both of the aforementioned dialog 
boxes you have several options 
for controlling the behavior of the 
keyword being edited:

Keyword Name: this is the keyword itself. If you’ve made a typo or spelling error, you can 
correct it here.

Synonyms: When you create a new keyword or edit an existing one, you have the option 
to include synonyms for the word. Synonyms are words that mean the same thing as the 
main keyword. On a case-by-case basis, you’ll have to decide whether it’s better to add 
a synonym or make a separate keyword. For example, the keyword “Autumn” could have 
the synonym “Fall”. This is likely more efficient than setting up “Fall” as its own keyword. 
“Vacation” could have the synonym “Holiday”, and so on. (Of course, you could also have a 

Keyword List
The Keyword List panel (see Figure 
3–97) shows an alphabetical list of all 
the keywords in the currently open 
catalog. As you add new keywords to 
photos using the various methods, 
they are automatically added to 
the Keyword List. You can use the 
Keyword List to add and remove 
keywords to/from photos and to 
modify the keywords themselves.

The Keyword List is sorted 
alphabetically; you can’t change the 
sort order of keywords in the list, but 
you can group keywords together in 
hierarchies or add numbers or special 
characters to keywords to control where 
they show in the list.

Maximum number of keywords 
visible in the list
It’s been reported that in some system 
configurations, the Keyword List will not 
show all the keywords actually contained 
in the catalog. A recent test on Lightroom 
running on Windows 7 indicates 3,271 
as the possible maximum number of 
keywords shown in the list. (I don’t know 
of any limit on os x.)

Keyword List icons
When images are selected, the Keyword 
List panel shows which keywords are 
applied to the selected photo(s). A 
checkbox to the left of each keyword 
indicates whether or not it’s applied 
to the photo (see Figure 3–98). A 
check mark indicates all selected 
photos contain that keyword(s); a dash 
indicates the keyword is only applied 
to some of the selected photos (like 
the asterisk in the Keyword Tags field), 
or that a single selected photo only 
contains some of the keywords within a 
hierarchy.

Figure 3-99

Figure 3-100

Figure 3-98

Figure 3-97

Parent

Child

Target keyword

⌘+Option+
Shift+K 
or 
Ctrl+Alt+ 
Shift+K
Set target 
keyword 
(keyword 
shortcut)
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at one time. When you drag-and-drop a lower-level child keyword onto a photo (or multiple 
photos), all the keywords above it in the hierarchy will also be applied.

You can also set the options differently for each keyword within a hierarchy. For example, 
within a single hierarchy, you could have some keywords that won’t be included on export. 
This approach provides infinite possibilities for using keywords as organizational tools.

With hierarchies, you can also have multiple instances of a keyword, grouped depending 
on syntax. For example, the word “Blue” could be under “Colors” and also under “Emotions”. 
As you’re keywording photos, you’ll find many words that have different meanings based 
on the context in which they are used; hierarchies accommodate this easily.

Working with keyword hierarchies
To make a keyword hierarchy, click and drag a keyword to place it over the keyword that 
will become the parent. The parent becomes highlighted. Release your mouse button to 
drop the keyword onto the parent, and the child becomes nested underneath.

You can also make hierarchies using commands from the contextual popup menu. Create 
a child keyword underneath a parent by right-clicking or Ctrl+clicking the keyword, and 
from the popup menu, select “Create Keyword Tag Inside [XYZ]…”. The new keyword will 
automatically be placed under the parent within the hierarchy.

Or, right-click or Ctrl+click on a keyword, and from the menu, choose “Put new keywords 
inside this keyword”. Any new keywords you make using any method will be automatically 
added as children of this keyword until you disable the option.

Use drag-and-drop when you want to move a keyword out of a hierarchy. 
Simply click on the affected 
keyword, and drag it to a new 
position outside the parent 
(see Figure 3–101).

Adding hierarchies 
during import
In text-entry keyword fields, 
such as the Keywording 
panel and Import window, you can manually add hierarchies. The keywording entry in 
the Import window works just like Enter Keywords in Library; it shows suggestions as you 
type. When you enter a nested keyword (if Auto-complete is turned on in Preferences), the 
rest is added automatically using the > symbol to denote the levels in the hierarchy. For 
example: London > England > United Kingdom > Europe

MANAGING YOUR KEYWORD LIST
The keywords stored in your Lightroom catalog have a unique, important place in the 
workflow and deserve regular attention all their own. It’s a good idea to do the bulk of 
your keywording work separately from other photo editing tasks. Periodically update your 

second entry for Holiday in a different, more generic context.) Lightroom uses synonyms 
when generating suggestion lists.

Include on Export: keywords that have this box checked will become embedded in all 
photos it’s applied to when those photos are exported. This includes Web galleries and 
files made with the Print to jpeg command in the Print module.

If this box is not checked, the keyword will not be included when the photo is exported. 
This feature is very useful when you’re using keyword hierarchies for internal organization 
but don’t want certain keywords to be exported (see below). For example, I have a 
keyword called “Geographic Locations”, under which are nested keywords for many 
specific regions and countries around the world. I want the specific place names to be 
included on export, but not the “Geographic Locations” tag.

Export containing keywords: if a keyword is nested in a hierarchy, this option 
determines whether or not the parent (upper-level) keywords will be included on export.

Export synonyms: determines whether or not a keyword’s synonyms will be included
on export.

Add to Selected Photos: does just that; if photos are selected, they will instantly have 
the keyword applied when it is created or edited. 

Put inside: if you had a keyword selected when you opened the Create Keyword Tag 
dialog box, this option allows you to make the new keyword a child of the previously 
selected keyword.

EDIT KEYWORD TAG
Edit a keyword by right-clicking or Ctrl+clicking it. From the popup contextual menu, 
choose Edit Keyword Tag… You’ll get the Edit Keyword Tag dialog box, which functions 
identically to the Create Keyword box (see Figure 3–99).

KEYWORD HIERARCHIES
In the Keyword List panel you can create keyword hierarchies, which are multi-level 
groupings constructed of parent and child keywords (see Figure 3–97). Think of keyword 
hierarchies like folders and subfolders in a file system where you have one “top level” 
folder, with multiple “subfolders” underneath. A similar model applies to hierarchies in the 
keywords list.

In the Keyword List, hierarchies are indicated by a triangle arrow at the left. Click the arrow 
to expand or contract the hierarchy.

Benefits of using keyword hierarchies
Keyword hierarchies provide several very significant benefits. For one, hierarchies allow you to 
keep your keyword list clean and orderly by grouping keywords into larger categories. Using 
hierarchies also greatly speeds the application of groups of common keywords to photos, all 

Figure 3-101
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This means that if you’ve already got an extensive keyword list, any time you’re importing 
more keywords, it’s likely that some of those keywords and/or hierarchies in the list being 
imported won’t be added to the catalog. Matching items will be ignored if they are in the 
same hierarchy order. It’s a good idea to evaluate both your list and the list being imported 
to determine any conflicts so you can resolve them before or after the keyword import.

Keywording strategies
Ieeally, every image in your catalog should have at least a few keywords assigned to it, 
and usually, more is better. Obviously, there’s no point wasting time applying keywords to 
photos you will never use, but as has been discussed previously, this can be difficult 
to determine today.

Most importantly, your final selects should have many keywords applied when you’re 
done processing them. Years from now, locating specific images will depend on the 
richness of the metadata you’ve applied, especially keywords.

And though an image can have many keywords, it’s also good practice to be careful 
with the words you use. Think about keywords in terms that a viewer unfamiliar with the 
photograph might use to describe it, and use both general and specific terms.

As important as the choice of words is, it can be tricky. For example, if you make a 
photograph of a crowded city street, would it make sense to add a keyword for every 
single item shown in the picture (e.g. Manhole, Lamp Post, Car, Pavement, etc.)? Does 
this add real value, or are more generalized descriptions right for this photo? It’s up to 
you to decide.

A photo of an eagle in flight could use keywords like Animal, Bird, Raptor, Predator and, of 
course, Eagle. But what about Freedom, Feathered, Talons, Airborne? Effective keywording 
is a creative exercise in language.

And with regard to language, if you’re an English speaker, for example, there’s no reason 
you must limit your keywords to English alone. I frequently use phrases—especially 
names—from the local dialect. For example, my Italy collections also contain the keyword 
“Italia”; Tuscany is also “Toscana”, etc. (This is most effective using synonyms, discussed 
earlier in this section.)

It’s up to you to decide how far to go with your keywords; the point is, use them. Add 
keywords early in you workflow and refine the keywords for your final selects. If you ever 
feel that keywording is taking too much time, keep in mind that this work will pay off 
later, and stick with it. If you use Lightroom’s shortcuts and batch processing features, 
your keywording will be much easier. Take control of your keywording—managing your 
catalog will become much easier and your photos will have a much stronger presence 
on the Web.

Keyword List: check for typos and spelling errors, create or fix parent/child hierarchies, 
update keyword sets and synonyms and purge unused keywords.

Remember that when you change any keyword in the list, Lightroom automatically 
updates all the photos containing that keyword.

Finding keywords in the list
At the top of the Keyword List panel is a text search box you can use for finding keywords 
within the list (see Figure 3–97). By default, the search box says “Filter Keywords”. As you 
type in the field, the keyword list dynamically updates to show only those keywords 
containing that string of text. To remove the filter, click the X at the right side of the box.

Renaming keywords
To change a keyword, right-click or Ctrl+click on it, and from the popup menu choose Edit 
Keyword Tag. This opens the Edit box with the name highlighted. Type in the new name 
for the keyword, and when you’re done, press Return or Enter. All photos containing that 
keyword will be updated.

Deleting keywords
Deleting a keyword from the catalog will also remove it from any photos to which it was 
applied. Right-click or Ctrl+click on the keyword, and select Delete… from the popup 
menu. Lightroom will prompt you with a warning. Click Delete to accept.

Purging unused keywords
This command allows you to remove all the keywords from the catalog that are not 
applied to any photos. Library module➔Metadata menu➔Purge Unused Keywords.

Import/Export Keywords
You can import and export lists of keywords to and from Lightroom. A standard 
keyword list is just a simple text file with a .txt extension; the Lightroom hierarchies are 
determined by tab levels. You can use Import and Export keywords to share keywords 
with other photographers and, more importantly, keep your Keyword Lists synced 
between multiple catalogs. Use the menu commands Metadata➔Import Keywords and 
Metadata➔Export Keywords. (There are structured keyword lists available for purchase 
and many photographers are sharing their own; there’s a list of keywording resources in 
the Appendix.)

Using a text editor or spreadsheet to edit keyword lists
You can open keyword lists in a text editor or spreadsheet program to view and edit their 
contents prior to importing them into Lightroom. In many cases this saves lots of time—
you can edit your keywords and set up your hierarchies using very simple word processing 
controls, instead of doing everything in Lightroom’s Keyword List panel.

About importing keywords
When you import keywords into your catalog, all your previously existing keywords remain 
intact. In the case of any conflicts, your original catalog keywords will take precedence. 
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About video file metadata
The use of metadata for video files is nowhere near as well-developed as is metadata 
for still images. When working with video in Lightroom, you can use most of the same 
metadata controls as you would for photos, including keywords, title, captions etc. and, of 
course, attributes. Video format can also be used as a file type criterion for filters and smart 
collections. The updated Metadata panel also provides an array of fields to enter metadata 
about video clips.

However, when you export video files from Lightroom, most of that metadata will not be 
included. This is partly because Lightroom’s use of video metadata is in its early stages of 
development, and also because most video file formats do not provide a dedicated section for 
metadata the way a still image file does.

So, though you can use metadata controls when 
working on video clips within the catalog, you 
won’t get much metadata in or out with those 
clips. All in all, standardizing metadata for video 
files still has a long way to go.

The Metadata panel
Lightroom’s Metadata panel, on the right panel 
group in the Library module (see Figure 3–102), 
contains information about the digital image 
file, such as name, location on disk, capture 
settings, etc. as well as any custom metadata 
you add to the photo. You can change the types 
of metadata shown on the panel by choosing 
from the popup menu in the panel header (see 
Figure 3–102).

New in Lightroom 4: in the Metadata panel 
you can now view and apply metadata for video 
files; the panel also has new fields added for 
different types of dng files.

Show Metadata for Target Photo Only
This command, under the Metadata menu (see 
Figure 3–103), controls the behavior of the 
Metadata panel to only show the metadata for 
the active (“most selected”) photo. This option 
is off by default—when you select multiple 
photos, the Metadata panel will reflect the fact 
that multiple photos are selected and will only 
show specific metadata when all the selected 
items share the same value.

USING KEYWORDS TO FIND PHOTOS
As you move your cursor over keywords in the Keyword List panel, note the white arrow 
that appears to the right of the keyword (see Figure 3–98). Clicking an arrow activates 
a Metadata Filter using that keyword as search criteria, applied to the All Photographs 
source. With the filter active, you can refine the filter settings or choose a different image 
source (lock the filter first). In the filter bar, you can hold ⌘ or Ctrl to select multiple 
keywords in the list. (If necessary, refer to the section about filters earlier in this chapter.)

Don’t use keywords instead of collections
Finding photos by keywords is usually most effective as a method of refining another 
source or searching your entire catalog. To gather sets of photos for longer term storage 
and retrieval, it’s better to use collections (and you can use smart collections based on 
keywords!)

Working with metadata
Metadata is one of the most useful, important properties of any digital image. Literally, it 
means “data about data”. Metadata is plain text information embedded in a special section 
of the image file’s program code. Metadata can describe all kinds of things about an image 
file and is used in a variety of ways by a computer system processing that file.

Because metadata is stored in a different part of the file than the pixel data, it can be 
created and manipulated independently from the pixel data. Image capture devices, such 
as digital cameras, write metadata into image files as they are created (exif metadata). 
Imaging software, such as Lightroom and Photoshop, can write metadata into files and 
can also modify that metadata later.

Probably the most well-known types of metadata are keywords, titles and captions, 
and attributes. Search engines look for keywords and display results containing them; 
photo sharing Web sites can display embedded captions and titles for images; even your 
computer operating system will recognize and display star ratings for photos that have 
them applied.

Lightroom also uses metadata to make image adjustments. For example, when you 
change the exposure, sharpening or white balance settings, those adjustments are stored 
as metadata in the catalog, and can also be saved onto your hard disk as xmp data, and the 
original pixel data in the file on disk is never altered.

When you’re working with your photos, don’t skimp on metadata. Start applying 
metadata to your photos during import and continually add and refine metadata 
throughout editing and processing—especially on your final selects.

Keep in mind that much of the work you do with metadata today will save significant 
time and effort later, and will make it much easier for you (and other people) to find your 
photos far into the future. Make it a habit to constantly enhance the quality and 
quantity of metadata in your photos.

Figure 3-102

Figure 3-103
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•	 ISO Speed Rating

•	 Focal Length

•	 Lens

•	 Subject Distance

•	 Capture date/time (Date Time Original, Date Time Digitized and Date Time)

•	 Camera make, model and serial number

•	 Artist

•	 … and possibly others, depending on your camera model

Assigning your name to the Artist field
You can use the utility software that comes with your camera to enter the name that appears 
in the Artist field. All the photos digitized with the camera will then have your name embedded 
in them. Note that if you buy a used camera or sell your camera to someone else this should be 
updated immediately.

GPS
If a photo has gps coordinates applied, Lightroom will display it here. Click the arrow at the right 
to go to the Map module with that location selected.

Audio Files
If you recorded voice notes with your image files, Lightroom will show and allow you to play 
them on the Metadata panel. A few cameras support audio recordings; otherwise, you can pair 
a separately recorded audio file. The base filename of the audio clip must exactly match that of 
the image file for Lightroom to find it. Click the button next to the audio clip filename to play 
the file. if no audio sidecar file exists for a photo, the field doesn’t show in the Metadata panel.

EDIT CAPTURE TIME
If the clock on your camera was 
incorrect at the time of capture 
or your image file does not 
have a date embedded, you can 
change the image capture time 
in Lightroom. In the Metadata 
panel, click the square button 
next to the capture time, or 
choose the menu command 
Metadata➔Edit Capture Time 
(see Figure 3–104). You can 

Metadata panel actions
The buttons to the right of many of the items in the Metadata panel provide shortcuts to a 
range of editing and updating features. To see the function of a button, place your cursor 
over it without clicking and wait a few seconds for a tool tip to appear (see Figure 3–102). 
Pay special attention to right-facing arrows: these provide time saving shortcuts to useful 
functions.

TITLE AND CAPTION
Metadata titles and captions are useful in many ways, and can be applied in the Metadata 
panel (see Figure 3–102). Most of all, they help other people find your photos and learn 
more about them. An image title should usually be a name or short phrase. Captions are 
often several sentences, describing who, what, where, when, why etc. about the photo. 
Depending on the subject of the photo, the caption is usually journalistic, describing a 
person, place or event.

Titles and captions are especially beneficial when presenting your work using the output 
modules, as they can be configured to display along with the photos. For example, you 
will likely use titles and captions extensively when making books. In Web galleries, title and 
caption contribute significantly to search engine indexing and phrase-based relevancy 
of your images on the Web. In addition to keywords, search engines will often read the 
contents of the Title and Caption fields and use those fields in their ranking algorithms.

For these reasons, I recommend adding titles and captions to all your best images, 
especially if you’re planning to present them to other people. In many cases, you can 
simplify and speed up this process using batch processing: select a group of images and 
enter a title or caption in the metadata panel; all the selected photos will have the new 
metadata applied.

EXIF
The camera writes exif metadata into the image file when you take the picture. exif includes 
all the camera settings at the time of capture. Most exif metadata cannot be edited in 
Lightroom but it can be useful when making processing decisions. Examples of some exif 
metadata shown in the Metadata panel are:

•	 Dimensions - resolution in pixels

•	 Exposure

•	 Exposure Bias

•	 Flash

•	 Exposure Program

•	 Metering Mode

Figure 3-104
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adding location metadata for people to find to your photos based on where they were 
taken, be sure to fill these in manually or by using the Map module.

Status
Like content, the Status fields are most commonly used within agencies and service 
bureaus. You can use these fields to help track jobs within a workgroup.

Copyright
This is the most important kind of metadata: that which identifies you as the creator and 
copyright holder for the photo. Even if you don’t use any other metadata or keywords, 
this is the one section you really must complete to protect your rights. I strongly 
recommend you apply copyright metadata to all your photos.

•	 Copyright Status: for setting the copyright status of your own work; in nearly all 
cases you’d choose “Copyrighted”. “Public Domain” and “Unknown” are also provided.

•	 Copyright: type your copyright text here, i.e. © 2012 Nathaniel D. Coalson. On 
Mac, press Option+G for the copyright symbol. On Windows, type Alt+0169 on the 
numeric keypad, or on the regular numbers with Num Lock activated. If you have 
trouble entering the copyright symbol directly, you can copy and paste it from a 
text editor.

•	 Rights Usage Terms: enter “All Rights Reserved” or “No use without written 
permission”, etc. (If you’re concerned about using precise legal terms, search for 
more information online or consult with a legal advisor.)

iptc Extension
Lightroom includes an expanded set of iptc metadata called iptc Extension. This schema 
provides additional types of information that can be embedded in image files, and 
together with iptc Core is referred to as the iptc Photo Metadata standard.

Metadata presets
As with all presets in Lightroom, metadata 
presets can save you huge amounts of 
time. In addition to working with metadata 
presets in the Import screen, you can create 
and modify them using the menu on the 
Metadata panel (see Figure 3–106).

SETTING UP STANDARDIZED 
METADATA PRESETS
Like the other parts of the workflow, you 
should establish and use a consistent system 
for your metadata presets. Use the same 
diligence in maintaining your presets and 
templates as you do with your file and folder 

adjust by specified date and time, shift by set number of hours (time zone adjust) or 
change to file’s creation date, if different than the other dates. The dialog box states that 
the operation cannot be undone, but you could always change the time again to correct 
any errors.

Filter by date
In the Metadata panel, click the arrow button next to the Date to show photos taken on 
that date.

IPTC METADATA
iptc metadata is comprised of a wide range of 
standardized categories for information about 
images. The most important fields—author, 
creator, copyright notice, contact information and 
keywords—are but a few of the many types of 
iptc metadata available. You can view and edit iptc 
metadata on the Metadata panel (see Figure 3–105). 
To add, change or remove metadata from any of the 
fields in the panel, click to activate the field, then 
type or delete the text. Be sure to press Return or 
Enter when you’re done in each field.

You can apply the same metadata to many photos 
selected at once. If you find you’re entering the same 
metadata over and over, you should set up a metadata 
preset, which is discussed in the next section.

Apply and jump to next photo
When you need to apply one type of metadata 
to different photos using different values, try 
this: instead of pressing enter after typing in your 
metadata, press ⌘+right arrow, or Ctrl+right arrow. 
This applies the typed text to the current image and 
jumps to the next image with the same metadata 
field highlighted.

Contact
Use this section to enter your address, phone 
number, Web site, email address, etc.

Content
The content fields are mainly used by news agencies and image archiving services.

Image
The most important image metadata fields are City, State/Province, Country and ISO 
Country Code. These fields are often referenced by search engines. If you’re dedicated to 

Figure 3-105

Figure 3-106



152

03

LIGHTROOM 4: STREAMLINING YOUR DIGITAL PHOTOGRAPHY PROCESS

153

LIBRARY

03

synchronizes file metadata (but not Develop settings) between multiple photos. The 
settings from the target photo will be applied to the rest of the selected photos. In the 
Synchronize Metadata window (very similar to the Metadata template editor), tick the 
boxes for the metadata to be synced. Anything that remains unchecked will not be 
modified in the target photos.

Auto Sync
When you have multiple photos 
selected, you can use Auto Sync. 
As you change metadata on the 
active photo, the metadata on the 
other selected photos is changed 
at the same time. To do this, use 
the Metadata➔Enable Auto Sync 
control or click the switch to turn it 
on (see Figure 3–109).

COPY/PASTE METADATA
You can copy and paste metadata from one photo to others. First, select the photo 
whose metadata will be copied and make sure everything is how you want it. Select the 
menu option for Metadata➔Copy Metadata; a window appears, similar in appearance 
to the Metadata Preset Editor, where you can choose which 
metadata to be copied by checking/unchecking the boxes 
(and modifying the text entries, if desired). When you’re 
done, click the Copy button. Then select the other photos 
for which you want to paste the metadata and use the 
Metadata➔Paste Metadata command.

Metadata Status
As previews are being rendered, Lightroom compares 
the catalog metadata with the actual file on disk. While 
Lightroom is comparing metadata you’ll see three dots in 
the top right corner of the thumbnail (see Figure 3–110). If 
a conflict is detected, Lightroom displays a status indicator 
in the Metadata panel and, optionally, on the thumbnail 
(see Figure 3–111). Sometimes changes have been made 
that Lightroom is not yet aware of; 
if Lightroom hasn’t yet checked the 
status of the file’s metadata, you may 
not see an indicator right away.

Show unsaved metadata cell icon
Press ⌘+J or Ctrl+J to show View 
Options and click the checkbox to 
enable Show Unsaved Metadata 

systems. You create and edit metadata presets using the Metadata Preset Editor 
(see Figure 3–107).

The contents of a preset should include items that you’d expect to apply to many images 
at once. Contact information, copyright notice, etc. make good candidates for presets. 
(Keywords don’t, since they are very image-specific.)

Give your presets clear, consistent names. I use my initials at the beginning of all my 
custom presets and templates so they are grouped together in alphabetical lists and I can 
find them easily.

Typically, my presets vary only in the year of copyright. All the other information, such as my 
address, phone number, and Web site remain consistent. This means that when entering a new 
year, all I need to do is make a new preset with a copyright change for that year.

Blank fields in a metadata template
If you create a metadata preset that 
includes blank fields, and then apply that 
preset to photos that previously had data 
in those fields, the blank fields will clear 
the existing metadata. Though in some 
cases, this might be a good way to clean 
up unwanted metadata, normally you’ll 
want to avoid it. Carefully choose the 
fields you include in your presets, and 
uncheck any blank fields to prevent them 
from being included. Lightroom 4 has 
new functionality for handling this, so it’s 
less likely to happen (see Figure 3–107).

To see all the Lightroom presets 
saved on your computer, choose 
Preferences➔Presets
…then click the button “Show 
Lightroom Presets Folder”. This opens the 
presets folder in Finder or Explorer. To 
remove presets from Lightroom, you can 
delete them from their folders. (Do this 
with Lightroom closed; the changes will 
be visible when you restart the program.)

SYNC METADATA
With multiple photos selected, the 
Sync button at the bottom of the 
right panel set (see Figure 3–108) and 
its corresponding menu command 

Figure 3-110

Figure 3-111

Figure 3-107

Figure 3-108

Figure 3-109
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Shift+A 
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Shift+V 
or 
Ctrl+Alt+ 
Shift+V
Paste metadata
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•	 Conflict Detected: this condition occurs 
when the file on disk contains different 
metadata than what’s in the catalog record. It 
usually means there is metadata in the file that 
is not present in the catalog—not just that 
the values have changed, such as keywords 
or iptc metadata added in another program. 
This warning can also indicate that the file 
has potentially been changed both in the 
catalog and on disk, resulting in mismatched 
metadata. The thumbnail icon displays a 
warning (see Figure 3–114); you will need to 
determine which version of the file is newer to 
resolve the conflict.

When Lightroom indicates there is a metadata conflict, take the necessary time to 
understand what’s happened and, if necessary, click the thumbnail icon or run the for 
Read Metadata from File or Save Metadata to File command, after which this indicator 
will show Up to Date.

Two-pass metadata checks
Lightroom makes two passes when checking metadata status. During the first pass, 
Lightroom simply checks the modification dates for the files on disk and compares them with 
the files in the catalog. If no file modification date changes are detected, the metadata check 
stops there. If differences are found, Lightroom performs a second pass, during which all the 
metadata is compared. For these reasons, sometimes Lightroom will indicate a status conflict 
at first, and then as files are re-read the status will be changed to Up to Date.

About camera raw files and xmp sidecars
Because Lightroom doesn’t directly modify raw files straight from the camera, any 
metadata applied to the files that you want to save on disk must be stored in sidecar files 
using the .xmp (Extensible Metadata Platform) format. When you run the Save Metadata 
to File command, if no sidecars exist, they will be created. Each sidecar file is associated 
with a specific image file, and contains all the metadata changes you’ve made to the 
raw file. This sidecar file must always accompany the raw file in order for those metadata 
changes to be preserved. This is one reason I recommend using dng for your raw originals 
instead of native camera raw files—you can save xmp metadata directly into dng files. You 
can learn more about dng in the Appendix.

xmp sidecars are listed on Metadata panel
In conjunction with the conflict status icon, the Metadata panel shows when a raw file 
has a sidecar saved with it. Look below the File Name field.

What’s the correct version?
Whenever you’re changing file metadata, it’s important to understand exactly which version 
is most current before proceeding. Other software can change your image file metadata 

(see Figure 3–112). When there’s a 
metadata status conflict, an icon 
will appear on the top right of the 
thumbnail. If no conflict is detected, 
the icon does not appear. I always 
leave this option enabled.

Keeping metadata in sync
If you’re going back and forth between 
Lightroom and another application, 
Lightroom’s metadata (including 
Develop adjustments) will need to be 
kept in sync with the files on disk. When 
editing raw and dng files, Lightroom’s 
uses xmp metadata to help ensure that 
other Adobe software recognizes the 
editing data and will show the same 
results. For example, if you have a photo 
in your Lightroom catalog for which you’ve made changes to in Adobe Camera Raw or Bridge, 
Lightroom will detect the change but will not automatically update the catalog preview. In 
this case, you’d use Read Metadata from Files to bring the current changes into the catalog. As 
another example, if you have a photo in the catalog to which you’ve applied new keywords, 
and you want to see those keywords in Bridge, you’d need to Save Metadata from Files from 
within Lightroom in order for Bridge to reflect the updates. The same applies to rendered files 
(tiff, psd etc.) which have been edited outside Lightroom: for the catalog to show the current 
version, you’d need to Read Metadata from Files.

Depending on the status of the metadata for the photos being previewed, the Metadata 
panel and thumbnail status indicator will show one of the following conditions:

•	 Up to Date: no conflict detected; all is in sync. Metadata in the file on disk matches 
the metadata in the catalog.

•	 Has Been Changed: the metadata in Lightroom 
is out of sync with the metadata in the file. This can 
mean either that Lightroom data is newer, or the 
file’s data is newer. Text in the Metadata panel will 
display Has Been Changed (see Figure 3–111). On 
the thumbnail icon, when Lightroom’s metadata 
is newer, a down arrow will be shown, indicating 
you should Save Metadata to Files (see Figure 
3–111). When the file on disk’s metadata is newer, 
the Metadata panel will read Changed on Disk and 
an up arrow is shown, indicating you should Read 
Metadata from Files (see Figure 3–113).

Figure 3-112

Figure 3-113

Figure 3-114
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Metadata Status and Synchronize Folder
When you run the Synchronize Folder command (discussed earlier in this chapter), 
you have the option to Scan for Metadata Updates. When you do this, Lightroom will 
automatically Read Metadata from Files when a conflict is detected.

Using the Painter
The Painter tool provides a powerful way to quickly modify many photo settings. With it 
you can add, remove or change all kinds of metadata and Develop adjustments with a 
single click. To use the Painter, first be sure the Toolbar is showing (T). Click the Painter icon 
to activate the tool (see Figure 3–115). Then, from the Paint: popup menu, choose what 
kind of settings you want to modify (see Figure 3–116); the Painter icon changes to reflect 
your selection. Next, configure the options for the changes you’ll be applying with the 
additional controls to the right. Then simply click on thumbnails in the Grid or Filmstrip to 
apply the Painter settings.

even if you don’t actually open the file using that software. Bridge is one such application; 
building previews for image files in Bridge often will alter file metadata, resulting in an apparent 
conflict with Lightroom. If you know the metadata in Lightroom is the most current, save it out 
to the files. Otherwise, check the files in question to figure out when and how the metadata 
was changed before reading metadata into Lightroom. (Of course, if you only use Lightroom 
for processing your photos, you won’t need to worry about this.)

Metadata Status as a criterion
New in Lightroom4: you can create filters and smart collections based on Metadata Status. 
This makes it easy to identify photos with out-of-sync metadata.

SAVING METADATA TO FILES
To save all the current Lightroom metadata out to the disk, use the Metadata➔Save 
Metadata to File command or the shortcut, or click the down arrow on the thumbnail. This 
writes all the Lightroom metadata, including Develop settings and keywords, to the files. 
If your files are dng, tif, psd or jpeg, the metadata is written directly into the image files. Raw 
files will have xmp sidecar files that store the metadata.

Saving your work is as important in Lightroom as in other software applications, but it’s 
all too easy to work for long periods of time without Lightroom prompting you to save. 
Though all your changes are automatically saved into the database, they are only in the 
database until you save the changes out to the files and/or export new files. So save often!

After import, save metadata to files
If you’ve applied any metadata during import, save it out to the files immediately after the 
import is done. I use Select All, then Save Metadata to Files, via the keyboard shortcuts.

Automatically Write Changes to xmp

The Catalog Settings➔Metadata dialog box provides this option to automatically save 
your metadata to the files as you work. I generally don’t recommend this, for several 
reasons. First, many computers will experience a decrease in performance with this option 
enabled. Second, even on a fast machine, I don’t want Lightroom accessing my files that 
frequently. Lightroom will save out the metadata after every change made to any setting. 
That much file access increases the possibility of file corruption. Third, and maybe most 
importantly, if Lightroom is always saving out metadata as you work, you won’t be able to 
use the Read Metadata from File command to go back to a previous version. Usually it’s 
best to just regularly save out the metadata yourself. (A notable exception might be when 
managing photos in workgroup environments.)

READING METADATA FROM FILES
If you’ve edited your files outside Lightroom (such as in Bridge, Adobe Camera Raw, 
Photoshop etc.) and want to update Lightroom to show the latest changes, you can read 
in the file metadata with the command under Metadata menu, or by clicking the up 
arrow on the thumbnail. This will update the photo’s metadata in the Lightroom catalog. 
Be careful using the Read Metadata from Files command; it can overwrite all your current 
Lightroom metadata for selected images.

Figure 3-115

Figure 3-116
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Enable painting



158

03

LIGHTROOM 4: STREAMLINING YOUR DIGITAL PHOTOGRAPHY PROCESS

159

LIBRARY

03

Step 4. (Optional) Apply adjustments to the proxy jpeg in Develop and save a preset.

Step 5. (Optional) Back in Library Quick Develop, apply the new preset to the video clip.

Step 6. Apply and refine adjustments using the Quick Develop panel.

Step 7. Export the finished video or publish it to Facebook or Flickr.

PLAYBACK AND PREVIEWING
Video clips appear in the Library view 
modes in basically the same way as still 
images, with a few important differences. 
In Grid view, the thumbnails display the 
duration of each clip (see Figure 3–117). You 
can move your mouse cursor horizontally 
across the thumbnail to scrub through the 
video preview. (The first time you do this 
there might be a short delay as Lightroom 
retrieves all the frames from the clip.)

Preview video in Loupe
Double-click a video thumbnail, or press 
the E key, to open a selected video in 
Loupe view. A large preview loads, with 
a control bezel below (see Figure 3–118). 

To use the Painter to remove some types of metadata, such as keywords, hold the Option 
or Alt key. The Painter icon changes to indicate you’re in erase mode. Click on photos to 
remove the specified metadata or adjustments from them.

When you’re done, click the button in the Toolbar or press Esc to turn off the Painter tool.

Paint Target Collection
Using the Painter you can add or remove photos in the Target Collection. This can be 
much faster and easier than dragging and dropping or using the contextual menus (but I 
still usually prefer the keyboard shortcut).

Working with video in Lightroom
New in Lightroom 4: the Library Loupe view now provides essential video editing 
controls such as high-definition playback (with no rendering required), trimming controls 
(setting in and out points), extracting jpeg images from video clips and the ability to apply 
Quick Develop adjustments and presets. You can export edited videos from Lightroom 4, 
and you can also use all of Lightroom’s metadata with video clips (although that metadata 
is not exported).

Video format compatibility
With Lightroom 4 you can import, play and edit videos from a wide range of devices, 
from smartphones to DSLRs and compact cameras, including Sony avchd files. Although 
Lightroom now natively supports internal playback of most formats, some video codecs 
are not supported directly and you may need to install Apple QuickTime for playback 
capabilities. (Lightroom will notify you if this is the case.)

Generally speaking, if you can import a video clip, the chances are good that you’ll be 
able to work with it using all the controls described in the following sections. However, 
understand that video editing is still new to Lightroom and can’t compete with dedicated 
video editing software such as Adobe Premiere. The video capabilities offered by 
Lightroom 4 are designed to serve the basic needs of photographers capturing video 
along with their still images and isn’t meant to be a full-fledged video editing suite.

Working directly with video clips is currently limited to Library module only. Video 
playback is color-managed in Lightroom.

EXAMPLE WORKFLOW FOR VIDEO
The Lightroom video editing workflow is very simple and straightforward; there really 
aren’t many options to configure. Following is an example:

Step 1. Trim the video. Use the controller to set new in and out points of the clip.

Step 2. Set Poster Frame. Choose the frame used for the Library and Filmstrip previews.

Step 3. Capture Frame. Extract a single frame as a jpeg (useful for applying Develop 
adjustments). Figure 3-118

Figure 3-117

Space bar
Play/pause 
video playback
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TRIMMING
Click the gear icon in the bottom right corner of the controller (see Figure 3–120). 
This expands the controller to show the timeline (individual frame previews) with trim 
controls at both ends. You can step forward or back one frame at a time using the arrow 
buttons to the left and right of the main play button. A vertical orange line above the 
playback head indicates the current position in the timeline; the current frame number is 
shown at the bottom left of the controller.

To set new in and out points for a video clip, drag the trim controls from either end (see 
Figure 3–120), or use the keyboard shortcuts to set the in or out point to the current 
playback head position: Shift+I sets the in point and Shift+O sets the out point. You can 
do this while the video is playing.

The trim controls will not go past the playback head. As you get close to the playback 
head, the trim controls snap to the playback head. This can make it easier to set the in 
and out point very precisely. Use the single frame advance buttons to step exactly to the 
frame where you want to set the trim point, and then drag the trim control to snap to 
that point.

SET POSTER FRAME
The Poster Frame is the preview 
image that shows in the Grid 
and Filmstrip. By default, the first 
frame of the clip shows as the 
preview, but you can change 
this. Since a video contains a 
sequence of unique frames, it’s 
important that you can choose 
the frame that best represents 
the content of the clip. To Set the Poster Frame, click the rectangular button near the 
bottom right of the controller and select the menu option (see Figure 3–121).

Slideshow uses Poster Frame
If you make a Slideshow that contains a video clip, the Poster Frame is used on the slide. 
You can’t currently play a video within a Lightroom slideshow.

Press the space bar, or click the play/pause button in the controller, to play and pause the 
video playback. You can also drag the playback head to advance the video, or scrub your 
cursor side-to-side over the time display. The controller is resizable—click and drag either 
end to expand or compress it.

View Options for video
In the View Options dialog box 
for Loupe view (accessed under 
the View menu) there are new 
options affecting video previews 
(see Figure 3–119). For starters, 
you can show the frame 
number when displaying 
video time. Most video clips 
you’ll work with use 29 or 30 
frames per second and showing 
the frame number allows much 
greater precision than time in 
seconds when trimming videos 
or extracting frames.

Play hd video at draft quality 
can help previews load faster for 
high resolution clips. Enabling 
this option sets the playback to 
1/4 resolution mpeg rendering to provide faster frame rates. If you’ve got a computer with 
plenty of power (processor speed, ram and video memory) you can probably disable this 
option to see better previews. (When draft quality is enabled and you pause a video, the 
current frame is rendered at full quality, at which time you may notice a slight change in 
appearance and overall quality. When draft mode is disabled the previews should appear 
identical whether the video is playing or not.)

Video Cache Settings
Lightroom 4’s Preference dialog box adds a new option for the Video Cache. The default 
is 3.0 GB and this is Adobe’s recommended size. Setting a larger maximum cache size can 
provide smoother playback using saved preview data. To force Lightroom to rebuild all the 
video previews, you can click the Purge Cache button.

Using the secondary display for video
The video controller is not available in the secondary window, so you can’t play videos 
there. However, you can set up the second window to show another view mode and play 
the video in the main window.

Figure 3-119

Figure 3-120

Figure 3-121

Shift+I
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Shift+O
Set out point
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EXPORTING VIDEO
You can export your edited video clips from Lightroom; all your trimming and 
adjustments will be used to create the exported file. Using publish services, you can 
also upload videos directly to social media sites like Facebook and Flickr. Exporting is 
covered in Chapter 5.

Next steps
Organizing your files in Library is one of the major pieces in the Lightroom workflow 
puzzle. Once you’ve isolated your favorite photos and put them into meaningful 
collections, you can confidently move on to enhancing them using the adjustments in 
the Develop module.

As time goes on, do your best to keep your catalog neat and tidy. Occasionally you’ll 
need to spend some time performing maintenance tasks like reorganizing collections, 
deleting unused presets and cleaning up your Keyword List.

BACK UP AND OPTIMIZE YOUR CATALOG
After you’ve done any significant amount of work in Library, you should back up 
your catalog. You can 
use Lightroom’s built-in 
backup feature for this. In 
Catalog Settings, under 
the Lightroom menu on 
Mac and the Edit menu on 
Windows, you can specify 
how often Lightroom will 
prompt you to do a backup 
(see Figure 3–122). I back up 
my catalog after every work 
session where I’ve made any 
major changes. I keep this 
set to “Every time Lightroom 
exits” and I just skip a 
backup if it’s not necessary. 
When you run a Lightroom 
backup, you should have 
Lightroom test its integrity 
and optimize your catalog 
(see Figure 3–123).

Even if you don’t do a 
backup, the Optimize 
Catalog command can 
be run from under the 
Lightroom menu on Mac 
and the File menu on Windows. 

CAPTURE FRAME
The Capture Frame command extracts a single frame from the video clip. Click the 
rectangular button at the bottom right of the controller and select the menu option to 
capture the current frame (see Figure 3–121). The frame at the current playback head 
position is rendered as a high quality jpeg and saved to disk in the same folder as the video 
clip, and then added to the catalog and stacked with the clip from which it was made. You 
can capture any number of frames from a single video clip; each of the jpeg file(s) are saved 
to disk using the file name from the original clip plus a sequence number automatically 
appended to the end of the file name.

QUICK DEVELOP VIDEO CLIPS
Videos can be adjusted using a limited subset of the same Develop controls you use for 
still images. (To learn about these adjustments read Chapter 4.) Using Process Version 
2012, the available adjustments for video in the Quick Develop panel are:

Treatment (Color or Black & White, including Auto B/W Mix) 
Auto White Balance 
White Balance (JPEG Equivalent) 
Auto Tone 
Exposure 
Contrast 
Whites 
Blacks 
Vibrance 
Saturation

Applying any of these adjustments will affect the entire video and can take a while to 
process. Note that Develop History is not saved for videos—you can use Undo or Reset All 
in the Quick Develop panel to revert your adjustments.

USE THE JPEG AS A PROXY IN DEVELOP
As noted earlier, you can’t process a video in the Develop module. However, you can 
Develop the jpeg generated by Capture Frame as a proxy for the video. When you’re done 
adjusting the jpeg in Develop, save a preset and apply it in Quick Develop, or use Sync 
Settings or copy/paste to transfer the settings to the video clip.

In the Develop module you can apply changes on the Tone Curve, Color Treatment, Split 
Toning and Camera Calibration panels, which can then be synced back to the video clip.

Auto-sync works too!
Try this: after you use Capture Frame, in Library select both the jpeg proxy file and the video clip. 
Make sure the jpeg is the target photo. Then go to Develop. Turn Auto-Sync on, using the switch 
at the bottom of the right panels. Work on your jpeg file, applying whatever Develop settings 
you want. The adjustments are simultaneously applied to the video clip! There’s one caveat 
here: only the adjustments in the above list will be used on the video—and any other Develop 
adjustments that you make to the jpeg will not be applied to the video.

Figure 3-122

Figure 3-123
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You can optimize your catalog any time, separately from doing backups. Regardless of 
your backup frequency, I recommend you optimize your catalog every now and then to 
keep things running smoothly. 

Keep in mind that with Lightroom backups, only the catalog itself is backed up, and not 
the image files or previews. For this reason, I also frequently use backup utility software 
to synchronize my hard drives. Using these methods, I have peace of mind knowing that 
if my catalog becomes corrupted or a hard drive fails, I have multiple current backups of 
everything.

You can learn all about working with catalogs, including backing up, testing and 
optimizing, in Chapter 11.


